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表現の注意点

*拡張子の*：*は任意の文字列を表す。サブサブサブメニューの先頭は*で表現されているので違いに注意する。

（用語：解説）：用語に対する定義を解説で説明する。

・：メインメニュー
＞：サブメニュー

＜：サブサブメニュー

*：サブサブサブメニュー

１や２など：サブサブサブサブメニュー

1.ネットワークに関する諸概念
　ネットワークとは、頂点（ノード）の部分集合とラインの部分集合の2つの集合により成り立っている。頂点の部分集合をユニット（Unit）、ラインの部分集合をユニット間の関係（Relations）という。それらは、グラフという。

ラインは、有向と無向に分けられる。頂点やラインの追加的な情報は属性として付属している。（例：名前、ラベル、タイプ、値など）[11]
 ネットワークは以下のように表される。
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グラフ(Graph)について

Actor（アクター）：頂点、ノード

Relation（関係）：ライン、無向線、有向線、リンク、タイ
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arc（a,d）に注目すると、aはinitial vertex,dはterminal vertexという。

edge（c:d）に注目すると、cとdはend vertexという。

iのように、どの頂点ともつながっていない頂点のことをisolated vertexという。

cの頂点にある自分から出発して自分に帰るラインのことをLoopという。

以下のようなものもある。

[image: image16]
2-modeネットワーク：Biparite（valued）graphsのこと。詳細は以下。

Temporal networks：動的ネットワーク。時間により変化

P-Graphs：系図
Multiple or multi-relational network：同じ頂点集合のネットワーク

2.Pajekの概要
2.1Pajekとは
本書は、windows用ネットワーク分析ソフトUCINETに組み込まれている大規模ネットワーク可視化ツールPajekのマニュアルである。
UCINET：UCINETは社会ネットワークとその他の類似データ解析を目的とするメニュー方式プログラムです。プログラムには、中立性と結合性測度、サブグループの検出と位置付けメソッド、確率論モデル（P1)、類似・非類似の測度、マトリックス相関（QAP）と多重マトリックス回帰（MRQAP）によるネットワーク仮説検定などの機能が含まれます。

これらのネットワーク解析機能に加えて、UCINETは、多次元スケーリング、クラスター分析、一致分析、および回帰分析などの多変数解析機能を備えています。さらに、データ変換と管理用のツール（線グラフの作成、グラフ転換、ノードと結線による事象マトリックス、値付き、または分割グラフからの多重グラフ作成、グラフのプール化、相関によるセミグループ）を備えています。これに加え、UCINETは完備したマトリックス代数演算言語を持っています。
[1] NetScience UCINET6 https://www.netscience.ne.jp/software/ucinet/

Pajekのネットワークデータの構造は*.net形式に従う。（*.netは、アスキーコードで書かれたファイル）*.netファイルを読み込むことにより、pajek内にネットワークが構成される。pajekを使うには*.netファイルを作る事が始めである。*.netファイルの作成は、テキストエディタから手書きで作ることも出来る。よって、生成されたプログラムに依存することなく、*.netファイルを作ればPajekで解析できるという意味でどのようなプログラムによって生成されたネットワークでも使うことが出来る汎用性が特徴である。
　Pajekで対象となるネットワーク

・普通ネットワーク（有向、無向、有向無向混合）

・マルチリレーションネットワーク

・2部グラフネットワーク

・動的ネットワーク

グラフ：頂点と頂点の関係の数学

ネットワーク：グラフ上を伝播対象が伝播する存在

伝播対象：HIV、風邪ウイルス、電力、（物理・化学などの）現象、状態（倒産など）、電波

　　　　　うわさ、パケット、感情など

数理生態学：拡散方程式やSIR・SISモデルによる８面格子状（４角形のグリットの上下左右と斜めの８つへの伝播）伝播を対象にする

拡散（伝播）ルール：拡散や伝播のルールを決めた方程式・アルゴリズム

ネットワーク生態学：さまざまなグラフ上（ネットワーク上）の伝播を対象にする。実際対象のグラフトポロジーで様々な伝播規則を用いるケースが多い

グラフトポロジー：グラフの形、グラフとも言う

グラフのリワイヤー：グラフの張りなおし

頂点特性：頂点が伝播を制御することもある。頂点が伝播対象を保持したり、抑制したりなど

伝播初期状態：伝播要素の初期状態

伝播決定要素：グラフのトポロジー、拡散（伝播）ルール、頂点特性、伝播初期状態の４　つ

グラフ評価：グラフ理論より、オイラー路（一筆書きできるか？）など

ネットワーク評価：対象グラフを伝播させてみる

類似度測定：グラフトポロジーは基本的に行列データなので、統計的手法によりネットワークの類似度などの測定が可能（グラフ理論の１つ）
Pajekで伝播を扱うことはできない。
PajekのNetwork analysisとは、グラフ評価（graph Analysis)のことで、伝播については扱わない。ただ、

· 伝播していく様子を可視化する

（*.timによるスナップショットの時系列可視化）

· 伝播の過程のグラフトポロジーの解析をする

（次数の数、次数分布、Coreなど）

ことはPajekで扱うことが出来る。

ネットワークの本質、「伝播」である。一般的にネットワークで一番知りたい本質は、対象がどのように伝播していくかであるからである。ネットワークトポロジー（グラフ）は、『伝播の仕方の構造』でしかない。つまり、Pajekでネットワークトポロジーを解析・可視化してもネットワークがわかったとはいえない。 


[image: image17]
2.2Pajekの使用
Pajekの使用するためには、どのような対象のネットワークでも、まず、*netファイルを用意しなければならない。それが、Pajekを使用する第一ステップである。


[image: image18]
2.3Pajekのインストールとその方法
　Pajekは以下のURLでダウンロードできる「フリーソフト」である。

Pajek関連サイト

　http://vlado.fmf.uni-lj.si/pub/networks/pajek/
　以上のURLから、ダウンロードし、インストールすればPajekを使用することが出来る。

2.4各種ファイルの説明
2.4.1*.netファイルの説明

[image: image19]
　*.netファイルは、上図のように頂点数の宣言部分と、ラインの宣言部分（有向線の宣言部分と無向線の宣言部分）に分かれる。

[image: image20]
１行目『*Vertices　頂点数』

読み込む際に、１行目の宣言頂点数とそれ以降に表示されている頂点データの数が合わないと、読み込みの際にエラーが発生する。

２行目~N行目『頂点番号　“ラベル”　横（x）座標　縦（y）座標　奥（z）座標』
（Nは指定頂点数）
z座標は省略可能。

注意点：*.netファイルに半角シフトでなく全角シフトが入るとエラーが発生するので注意する。

さらに以下のコマンドで頂点を詳細に設定できる。

　　・形

・大きさ

　　・色

　　

	設定項目
	コマンド
	意味
	例

	形の設定
	elipse
	楕円形にする
	　

	
	box
	四角形にする
	　

	
	diamond
	菱形にする
	　

	
	triangle
	三角形にする
	　

	
	empty
	ノードを表示しない
	　

	大きさの設定
	x_fact
	x軸方向に何倍拡大するか
	x_fact 3：x方向に3倍拡大

	
	y_fact
	y軸方向に何倍拡大するか
	x_fact 5：y方向に5倍拡大

	色の設定
	ic
	ノードの内側の色を設定
	ic Red：ノード内を赤色にする

	
	bc
	ノードの枠の色を設定
	bc Blue：ノードの枠を青色にする


表：頂点の設定項目のコマンド

　色の設定は、RGB（Red Green Blue）で指定も出来る。

　例：ic 0.500 0.500 0.500
　　先頭『*Arcs』
　　それ以降の指定『出頂点番号　入頂点番号　重み』

　　で、有向線を指定することが出来る。*Arcs全体を省略することが可能である。
　　先頭『*Edges』
　　それ以降の指定『出頂点番号　入頂点番号　重み』

　　で、無向線を指定することが出来る。* Edges全体を省略することが可能である。


[image: image21]
　　さらに以下のコマンドで頂点を詳細に設定できる。

　　・ラベル
・色
　・形
	設定項目
	コマンド
	意味
	例

	ラベルの設定
	l
	ラベルを付ける
	l nakama

	色の設定
	c
	紐帯の色を設定する
	c Green

	形の設定
	p Solid
	紐帯を実線にする
	　

	
	p Dots
	紐帯を点線にする
	　


表：ラインの設定項目
　　　　色の設定は、RGB（Red Green Blue）でも設定できる。

        例：c 0.700 0.700 0.700
　　　　紐帯の実線・点線のデフォルト設定は、
　　　　　・ラインの値（=重み）が正→実線

　　　　　・ラインの値（=重み）が負→点線

　　　　となっている。


[image: image22]
拡張子を.netに指定すれば、PajekのMeinスクリーンで読み込め、そのファイルをPajekで解析、可視化できる。
2.4.2*.clsファイルの説明
　頂点に対するクラス分けの数字が入る。そのため

・整数

・離散数（連続でない）

　である。


[image: image23]
クラスと可視化の色の対応はDraw windowのOptions>Colors>Partition Colorsによって確認できる。

図：*.cluのクラス番号と色分けの色の設定
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図：*.clsのメインスクリーンのEditの表示
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2.4.3*.vecファイルの説明
　頂点の大きさを決定する値である。

　・自然数

・連続数
である。


[image: image28]
*.Vecのデータを「Vector量」と呼ぶならば、Vector量と可視化時の頂点の大きさには以下の関係がある。
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[image: image30]
[image: image31.png]Redisplay.

Vertex

val

Label A

9000000
0243700
0363373
0000000
0122511
0000000
0000000
0421520
oesee1s
0770363
0000000
0122511

6 oaa=0o000a060=

[E:




図：*.vecのメインスクリーンのEditの表示

2.4.4*.perファイルの説明
　　*.perは頂点の並び替えのためのファイルである。このファイルは可視化に反映されない。

[image: image32]
　頂点の再配置とは、下図の如く、言い換えるとラインの張替えである。したがって、*.perはラインの張替えのためのファイルであるといっていい。

　頂点は張替えられたあとも、ラインの接続関係のデータはそのままであることには注意する。

　ラインの張替えは、ネットワークサイエンスでよく用いられている手法・手段であり、Pajekでは、「*.per」がこれを受け持つ。
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図：*.perのメインスクリーンのEditの表示

2.4.5*.clsファイルの説明
　　　全頂点の部分集合が入る。つまり。クラスターの情報が入ったファイルである。

[image: image36]

[image: image37]
つまり、対象ネットワークを「クラスターかそれ以外か」に分けると考えてよい。

[image: image38]
Edit表示をダブルクリックすると、その頂点番号のデータを消すことが出来る

Add new vertexをクリックすると新しい頂点の情報を追加できる。


[image: image39]
2.4.6*.hieファイルの説明
　階層ネットワークの階層のデータが入っているファイルである。
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[image: image41.png]B Report

File

Root

<

27
22
3
6
H
18
16
13
7
10
&
H
12
1
15
H
1s
7

15
23
3

25
21
20
26
24
1

(108)

)
@
(72)
(187
(1s0)
)
(51
(24
(154)
(75)
)
57
(35)
(s5)
iy
(14s)
)
@
171 2
172 (21
)
Y
o)
s m
au

a1z
sz
53 21

)

@)

)

w

)

W

)
s 3
suz

@





図：*.hieのメインスクリーンのReportの表示

[image: image42.png]File Edit





図：*.hieのメインスクリーンのEditの表示


[image: image43]
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2.4.7*.pajファイルの説明
　　* .netから*hieまで、Pajekに関するファイルを一つにまとめたもの。
2.4.8*.logファイルの説明
　過去に行われたセッションを記録し、再現することが出来る。
2.4.9*.timファイルの説明
　ネットワークの成長タイムイベントを指定することが出来る。時間的にネットワークが変化するので、「動的ネットワーク」と呼ぶこともある。
　
[image: image45]
　「タイムイベントを可視化で反映する」には、以下の手順を踏む。
1 File>Time Events Network>read

2 *.timファイルを読み込む

3 Net>Transform>Generate in Time>All

4 Select Last Time pointで可視化するステップの最後（どのステップまで可視化するか）を指定。より正確に表現するなら、どのステップまでネットワーク（*.net）にタイムを生成するか？（Generate in Time）を指定する。

5 Select Stepを入力する。何ステップ毎に可視化したいか（Generate in Time）したいかを決定する。

タイム（ステップ）毎の可視化=*.netにタイムを生成させる

6 可視化する（Draw）

7 DrawメニューのNextやPreviousで、現時点の可視化するステップを指定できる。

	設定項目
	コマンド
	意味

	タイム
	TI t
	tステップ目のイベントを以下に書くことを宣言

	
	TE t
	･･･・・・・・・・・・・・・・・を以上で終了する宣言

	頂点(Vertices）
	AV v n s
	頂点を作る

	
	HV v
	・・・・を見えなくする

	
	SV v
	・・・・を見えるようにする

	
	DV v
	・・・・を消す

	
	CV v s
	・・・・の特徴を変える

	有向線(Arcs）
	AA u v s
	有向線を引く

	
	HA u v
	・・・・・・を見えなくする

	
	SA u v
	・・・・・・を見えるようにする

	
	DA u v
	・・・・・・を消す

	
	CA u v s
	・・・・・・の特徴を変える

	
	CD u v
	・・・・・・の方向を変更する

	無向線(Edges）
	AE u v s
	無向線を引く

	
	HE u v
	・・・・・・を見えなくする

	
	SE u v
	・・・・・・を見えるようにする

	
	DE u v
	・・・・・・を消す

	
	CE u v s
	・・・・・・の特徴を変える

	
	EP u v s
	・・・・・・を両向有向線に変更する

	両向有向線
	PE u v s
	両向有向線を無向線に変更する

	
	AP u v s
	・・・・・・・・・・を引く

	
	DP u v
	・・・・・・・・・・を消す

	有向線と無向線
	CT u v
	有向線と無向線の変更


表；タイムイベントのコマンド

　
	タイム
	t
	時間（ステップ）番号

	頂点
	v
	頂点番号

	
	n
	ラベル

	
	s
	特徴

	ライン
	u
	ラインから出る頂点番号

	
	v
	ラインが入る頂点番号

	
	s
	特徴


表：タイムイベントコマンドの値記号の意味
特徴とは、重さ・形・色などの詳細な属性のこと。

ラインは、無向・有向・両向有向・無向と有向の変換の4つのこと。
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2.5Pajekの各種ウインドウ
　Pajekは、ウインドウベース（ウインドウで構成されている）プログラムである。主に、以下の4つのウインドウにより構成されている。
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　　1、メインスクリーン：ファイルの読み書き・コマンド入力という中心的ウインドウ
　　２、可視化：ネットワークを可視化するためのウインドウ。
　　３、Report：処理情報を表示するウインドウ。
　　４、Edit：ファイル情報を表示するウインドウ。
2.6Main Screenの構造

[image: image49]
1.Networkのボックス

*.netを読み込み、読み込まれたファイル名を表示する。* .netはネットワーク情報である。Pajekの処理のため、中心的なファイルで、これを元に様々なファイル(*.clu、*.vecなど)が生成される。
2.Partitionsボックス

頂点の分類のためのファイル*.cluが読み込まれたら表示されるボックス
（Partitionなのに、拡張子が*.cluであることに注意）

3.Vectorsボックス

*.vecファイルが読み込まれたら表示するボックス。*.vecファイルは、
頂点の大きさに反映される。

4.Permutationsボックス

頂点番号の再配置のための*.perファイルが読み込まれたら表示するボックス。

このファイルは視覚化に反映されない。

5.Clustersボックス

頂点の部分集合（サブネットワーク、つまり、クラスター）を作るための*.clsファイルが読み込まれたら表示するボックス。
このファイルには、ラインの情報がない。
このファイルは視覚化に反映されない。
6.Hierarchies

階層的に頂点を整える*.hieファイルが読み込まれたら表示するボックス。
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Subgroups：階層ネットワークになったときの頂点の部分集合のこと
Root・Leaf：枝葉の関係。一階層上位の1つの頂点をRoot（枝）とし、それが所有している下位の1または複数の頂点をLeaf（葉）という。この関係はどの階層の頂点でも成り立つ。
　以上をまとめると、メインスクリーンの各ボックスと読み込まれるファイルの種類（拡張子）は、下図のようになる。
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3.メインスクリーン上のツールバーの各種メニュー
3.1File
Pajekの処理に必要な各種ファイルの基本的処理（Read,Edit,Save,Change label,Dispose)を行う。
>networks
<Read
*.netファイルの読み込みを行う。*.netはアスキーコードで書かれたファイルなので、テキストエディタで編集できる。

<Edit

編集したい頂点を選択し、その頂点のリンクを追加・削除できる。

つまり、対象ノードのリンクを編集できるが既存のリンクは修正できない。

修正したい場合は、一度リンクを消去し、それから追加しなければならない。

<Save

*.netファイルをセーブする。

<Export Matrix to EPS
ネットワークのマトリックス（行列）をEPSファイルとして書き込む。
EPS（Encapsulated PostScript）：画像ファイルフォーマットのひとつ

ここでいうマトリックス（行列）とは、ネットワークの視覚化情報をコンピュータ上であらわすデータ構造のことである。以下の、サブメニューは、EPSへの書き込み方である。
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*Original

初期状態でEPSファイルに書き込む。1-mode なら1-modeで 2-mode なら2-modeで書き込む。

1-mode：2部グラフでないネットワーク（通常のネットワーク）

2-mode：2部グラフ（同じ頂点部分集合にリンクがないネットワーク）
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*Using Permutation

Permutationの.perを反映したEPSファイルの作成　
*Using partition

Partitionの.clsを反映したEPSファイルの作成

1.strructual

クラスター：Partitionによって生成されるグループのこと

濃度：クラスター内の頂点の数/ネットワーク全頂点数

　　　で表される。クラスターがネットワークでどれだけの位置（数、大きさ）を占めるかを表現できる。各クラスターに1つずつ属性としてつく数字で、クラスターを表す指標のひとつである。ネットワークには複数のクラスターが存在することが普通であるから、1つのネットワークに複数の濃度の値が存在する。

　　　濃度を設定すればどのような頂点がクラスターわけされるか決まる。ため、（クラスター分類）＝（濃度の決定）である。

クラス：クラスターのこと。また、2部グラフにおいては、2部グラフの一方と他方のひとつずつを表す。
濃度はクラス間のラインの取りうる最大値に従い標準化される（決定される）。
クラス間のライン：クラスとクラスをつなぐラインのこと。

ネットワークは、濃度を反映した、つまり、クラスター分類したネットワーク（Dense Network）に整形される。

2.Delta

濃度はクラス内にある隣接ノードの最大入力・出力値を持つ頂点（複数）に従い標準化される（決定される）。ネットワークは、まばらネットワーク（Spare Network）に整形される。

*Only Black Borders
すべての、チェックされた行列の中にあるマトリックスは、Black bordersを持つことになる。違う言い方をすれば、white and light squaresを持つことになるDark squaresは、Black bordersを持つことになる。

<Change label

*.netファイルの名前変更
<Dispose

*.netファイルを消去する

>Time Events Network

ネットワークのタイムイベントを読み込む。
<Read time Events

ctrl+Tでショートカットでき、タイムイベントファイルを読み込む。
<save time Events

ctrl+Iでショートカットでき、タイムイベントファイルを書き込む。
>Partition
Pertitionボックスに関する.clsファイルの（Read,Edit,Save,Change label,Dispose)の処理を行う。
<Read

<Edit

<Save

<Change label

<Dispose

>Permutation
Permulationボックスに関する.perファイルの（Read,Edit,Save,Change label,Dispose)の処理を行う

<Read

<Edit

<Save

<Change label

<Dispose

>Cluster
Clusterボックスに関する.cluファイルの（Read,Edit,Save,Change label,Dispose)の処理を行う

<Read

<Edit

<Save

<Change label

<Dispose

>Hierarchy

Hierarchyボックスに関する.hieファイルの（Read,Edit,Save,Change label,Dispose)の処理を行う

<Read

<Edit

<Save

<Change label

<Dispose

>Vector
Vectorボックスに関する.vecファイルの（Read,Edit,Save,Change label,Dispose)の処理を行う

<Read

<Edit

<Save

<Change label

<Dispose

>Pajek Project File
<Read pajek

*.paj：networksからvectorまですべてのデータが含まれているファイル

*.pajを読み込む。
<save pajek

*.pajを書き込む

>Repeat session
　セッション：Pajek上で過去に行った処理

Logファイル：Pajek上で過去に行った処理が適宜記憶されているファイル

*.logファイルを選択させる。過去のセッションを、*.logファイルを選択させることで再現する。
メインスクリーンのNetworks2段目にログファイルが読み込まれる。
>Show Report Window

*.netファイルに関する簡単なレポートをWindowに表示する

>Exit

pajekを終了する。
3.2Net

1つのネットワーク(*.net)に対する情報追加を行う。また、ネットワークの変形に関するさまざまな処理を行う。

>Transform

<Transpose

選択したネットワークの置換を行う。

*1-mode

1-mode（network）：普通のネットワーク。2-modeでないネットワーク。

1-modeネットワークの有向線の向きを変える。
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*2-mode

Rows（行）とCols（列）を置換する。

2-mode：2部グラフ

Row：行

Col：columnの略、つまり、列
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<Remove
ネットワークの構成要素の“消去”を行う。
Removeで行う処理と同等の操作は*.netファイルのarcsやedgesのラインを手動消去することである。このメニューは、膨大な数の頂点・ラインをメニューで消去することが出来る。

ライン：以下の図を参照
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*Selected vertices

選択した頂点を消去する。

手順

①『Selected vertices to remove』のコマンドボックスが出るので、消去したい頂点番号を入力する

②入力した頂点が*.netファイルから消去される。

*All Edges

選択したネットワークのすべてのエッジ（無向線）を消去する。
*All Arcsを押す

選択したネットワークのすべてのArcs（有向線）を消去する。
*Multiple Linesを開く

選択したネットワークのMultiple Lineを消す。
Multiple line：特定の有向線(Arc)や無向線(Edge)、すなわち、特定の「順序（秩序、配列）ある」または「順序（秩序、配列）ない」頂点のペア、一回以上起きるとき、これらは、Multiple lineである。
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　　　　　　つまり、特定のライン（Multiple Lines）を消すということである。
1.Sum Values

Values：edgeやarcの重みの値のこと

すべての消去されたラインの値は、一致した２頂点間の消去されていないラインの値が加えられる。
重みを考慮したくなくなったとき

edgeやarcの頂点間の線は消さずに、重みだけ消す。

重みはすべて1になる
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2.number　of　linesを押す

オリジナルのネットワークの2頂点間の値を新しいネットワーク2頂点間に一致させる。

Sum Valuesとどこが違うか？

3.Min value

すべての２頂点間の最小値を選ぶ

繰り返し行うと、少ない値から消えていく

4.Max value

すべての２頂点間の最大値を選ぶ

繰り返し行うと、少ない値から消えていく

5.Single Line
重みを１にする。
*loops

ループ(loop)：ある頂点から出て同じ頂点に入る。
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ループを消す。

ループのないネットワークにしたいときの処理。
*Lines with Value

1.lower than

特定の値より低い値（line values）のラインをすべて消去する。
2.higher than

特定の値より高い値（line values）のラインをすべて消去する。
3.within interval

特定の値間のラインをすべて消去する。
*All Arcs form each Vertex expect
各々の頂点が予測するすべての有向線。有向線ネットワークでなければならない。
1.K with Lowest Line Values

Sort=分類する、種類

ラインを出ラインの値（重み）に従った昇順で頂点間を分類する。選んだ数字の最小ラインを保つ。
　　　K：指定した数字

　　　入力手順

　　　　①How many lowest output arcs to keep,0 - keep

2.K with Highest Line Values

ラインを出ラインの値（重み）に従った降順で頂点間を分類する。選んだ数字の最大ラインを保つ

<Add　

ネットワークの構成要素の“追加”を行う。

*Vertices

頂点の追加。同等処理は、*.netファイルのVerteicsのテーブルに、新しい頂点情報を書き込むことである。

*Source and Sink

sink：流す

もし、非環状のネットワークなら（acyclicのネットワーク以外は受け付けないメニューである。）、固有のはじめと終わりのVertexを追加する。下例では、始めが101、終わりが102になる。）新しいネットワークは、２つの人工の２頂点を持つ。（頂点101と102のこと）
　入力項目

　　①Values on lines added（加えられる頂点から追加されるラインの値）
図：Add *Source and Sink


[image: image61]
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*Default Vertex Labels

現在の頂点ラベルからデフォルトのラベルへ再配置する。デフォルトのラベルとは、『v頂点番号』である。
例：各ラベルが以下のように変更される。
   　*Vertices 3

　　  　1  “c”→”v1”
　　 　 2  “n”→”v2”
　　　  3  “p”→”v3
*Vertex Labels from File

別の*.netファイルを読み込み、そのラベルを、現在pajekに読み込まれている*.netの頂点ラベルに書き換える。
*Line Labels as Line Values
　　ラインのラベルを、ラインの値（重み）と共に再配置する。

*Sibling Edges

Sibling（兄弟の一人）

Sibling Edges：

兄弟無向線の共通した頂点を加える。

　1.input

先祖の有向線

2.Output
　　　　子孫の有向線
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<Edges->Arcs

Convert all edges to arcs (in both directions) (make　directed network)

Both directions=両向

無向線を両向有向線にする。

[image: image64]
.netファイルには、以下のようになる。


[image: image65]
[image: image66.png]



図：無向線から両向有向線に変換した例

<Arcs->Edges

*All

すべての有向線（Arcs）から無向線（Edges）へと変換する。つまり、

有向ネットワークから無向ネットワークを作る
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*Bidirected only

Bidirect：both direct

Bidirect：両向有向
両向有向線のみ無向線とする。
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両向有向線は、2つの逆向きの有向線を重ね合わせた形であるが、以下のように2つの有向線のラインの値（重み）が違うこともある。
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1.Sum Values

新しい無向線は、両向有向線の値の合計値である。

上例では、1-2の無向線の値（重み）は1+10=11となる。
2.Min Value
新しい無向線は、両向有向線の値の最小値である。

上例では、1-2の無向線の値（重み）1となる。
3.Max Value
新しい無向線は、両向有向線の値の最小値である。

上例では、1-2の無向線の値（重み）10となる。
<Line Values

ラインの値（重み）を変化させる。

＃ラインの値（重み）について＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃
　ラインにも値（重み）がつくことがある。そのラインに伝播がされればされるほど多くの値（重み）がつくと考えてよい。例えば、道路でも交通量の激しい道路と少ない道路が存在し、それらを同列に考えるよりも値（重み）を付けて考えた方がより実質的である。可視化についてもラインの値（重み）により、ラインが細くなったり太くなったり（あるいはより黒く、からより白くとの色分けがされたり）とラインの値（重み）を反映した可視化も存在する。

　　Draw window：Options>Lines>Different width あるいはGray scaleをチェック。（詳細は、これらのコマンドの説明しているページへ）
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　　　　　他にも、

　　　　　　　　ラインの値が大きい=伝播の確率が高い

　　　　　という意味もある。

　　　　　これらのように、ラインの値（重み）は重要な意味を持つ。
＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃＃
*Recode
　ラインの値を選ばれた間隔（頂点間）とこの方法でのラインの値（重み）の再設定に従い確率的に分配する。

　入力項目

　　①Dividing values or #Clusters
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のnを入力。つまり1~100のラインの値（重み）のn個のクラスに分割する。

    ②Generate new network with line values recorded in this way?

       Yse/no

       Yes：この方法で作られたラインの値（重み）を新しいネットワー

　　　　　　ク（*.net）に反映する。

　　　 No：反映しない。
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*Multiply by

継続的にラインの値を増やす

　入力項目

　　①Multiply line values by

    　　継続的に増やしていくラインの値（重み）の数

*Add Constant
継続的にラインの値（重み）を加えていく。

　入力項目

　　①Constant to add to line values
*Absolute
　Absolute line values

*Absolute+Sqrt
  Square root of line values

Sqrt：Square root

*Truncate
  ラインの値（重み）を切り捨てる。
*Exp
　Exponent line values

*ln
  Natural logarithm of line values

*Power
  Selected power of line values

  Power：

*Normalize

ラインの値（重み）を標準化する。他のネットワークのラインの値（重み）と比較しやすくなる。

1.Sum

ラインの値の合計値を１とし、その前提の下で、すべてのラインの値を再計算する。

2.Max

最大値のラインの最大値を１とし、その前提の下で、すべてのラインを再計算する。
<Reduction

 　　　　以下の対象を縮小する。
*Degree

　　　　　　　選んだ値よりも小さいすべての頂点を（縮小的に）消す。

1. Input
2. Output
3. All degree

　　　　　　　操作は、選ばれたネットワークを限定的にすることが出来る。

　　　　　　　
*Hierarchical
0か1の隣接 (Neighbor)をもつすべての頂点を（縮小的に）消す。
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結果は、簡素なネットワークと消された頂点の階層となる。

オリジナルのネットワークは最後に元通り(restore)にする。
*Subdivisions
   　Subdivisions：副分割、副分配、副分類

　　　正確に２隣接をもつすべての頂点を消す。（2つのラインと共に）

　　　2隣接とは、上記の0や1の隣接と同じく2つの頂点とつながった、次数2の頂点のことである。

　　　代わりにそれら2つの近接に直接、ラインを加える。
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　　　結果、可視化するのにちょうどよい簡素なネットワークになる。

　　　だだ、オリジナルのネットワークは最後に元通りにならない。

*Design(McCabe)
　　　すべてのネットワークの部分をMcCabe（グラフを描く際のプログラム）に従い縮小する。同サイズのPartitionが必要。

[image: image76]
有向線が追加され、頂点数も327から222へと減少する。

*Structural(flow graph)

<Generate Time

読み込まれた*.timファイルに従うステップ時の状態を*.netファイルへ。

特定の時間かその間を取る。

　　　　　－：頂点間の限界(Interval of limit)より少ないか多いかで分ける

  　　　　‘：頂点間を分ける

　　　　　＊：無限大

例：Vertices 3

    　　　　　1 “a” [5-10,12-14]

    　　　　　2 “b” [1-3,7]

    　　　　　3 “e” [4-*]

    　　　　　Edges

    　　　　　1 2 1 [7]

    　　　　　1 3 1[6-8]

  　　　　　  頂点aは、5~10と12~14のタイムで働き（Active）頂点ｂは、1~3、7のタイムで働き、頂点eはタイム4から働く。ライン１から2はタイム7で働き、ライン1から3はタイム4から働く。（3番目の数字は重み）

　　　　　　　指定されたタイムのときのみ、現在のネットワーク（temporal network）に表示される。

*All
すべての特定の時間のネットワークを生成する。
*Only Different

変更点が存在したときのみ、ネットワークを生成する。
*Interval

　　　　　　　選択されたInterval（時間）を与えたラインや頂点のあるネットワークを生成する。
<1-mode to 2-mode

1-modeから2modeネットワークを生成する。

<2-mode to 1-mode

2-modeから1-modeネットワークを生成する。
*Rows

結果は、ネットワーク間の行要素（アクター)間の関係を入れたネットワークとなる。

ラインの値（重み）が、2アクター共通のイベントの数を数える。

*Columns

結果は、列要素（イベント）間の関係を入れたネットワークとなる。

ラインの値（重み）が、互いのイベント間を構成するアクターの数を数える。

*Include loops

それぞれのアクターのイベントから合計値（互いのイベントのアクターの数の合計値）にループの値を入れたいとき、このメニューを使用する。
*Multiple lines

頂点が存在する間にMultiple lines存在する箇所に、値のない1-modeネットワークを生成する。

*Normalize 1-mode
　2-modeから1-modeになった1-modeネットワークを標準化する。

　オプションには「Include loopsのチェック」と「Multiple linesのチェックをしない」がある。
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2-modeから1-modeになった1-modeネットワークは、見やすくない。（ほとんどまばらでない。）そこで、以下のようにまばらにすることも出来る。
 Net>Transform>Remove>Lines with value>lower than
*Rows=Cols
　同じ頂点数の部分集合（First subsetとsecond subset）をもつ2-modeを1-modeに変換する。当然、2つの部分集合は同じ頂点数の2-modeネットワークでないと処理を受け付けない。

[image: image78]
<Multiple relation

*Extract Relation(s)
　選択されたmultiple relations networkから、選択された関係リスト（List of relations）かそれを引き出す。

　入力項目

　　①Relation Number(s)の選択

*Canonical Numbering
　1,2,...と順次的に関係の数を数え上げる。

*Generate 3-Mode Network

1-modeか2-modeの相互関係（multirelational network)ネットワークから3-modeネットワークを生成する。
Multirelational networkの互いのラインｒ： i j v

(iからjへ行く、値vのrelational number r)


[image: image79]
                     N：1-mode(first mode)の濃度

　　　　　　　　　　 M：2-mode(second mode)の濃度

　　　　　　　　　　　　　　　　・1-mode network
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                      以上の関係式から、新しいラインが創出される。


[image: image81]
*Line Values->Relation Numbers

ラインの値（重み）と同じ関係番号を保存する。（ラインの値は、完全な小数点以下切捨ての値：実数の整数化）つまり、ラインの値（重み）を関係番号にする。（Line Values→Relation Numbers）
*Relation Numbers->Line Values

関係番号と同じラインの値（重み）を保存する。つまり、関係番号をラインの値（重み）にする。（Relation Numbers→Line Values）

*Change Relation Number/Label

関係番号をラベルと一致した値の新しい関係番号に置き換える。
<Sort Lines-
　ラインの並べ替えを行う。

*Neighbors around Vertices
　近隣の回りのラインの並び替えを行う。
　他の最終頂点（End-vertex）に従った昇順の中で、互いの頂点の並び替たラインに結合された、互いの頂点の並び替たラインに向かって、近隣の周りの頂点のラインを並び替える。

*Line Values
  ラインをラインの値（重み）に従い、昇順か降順に並び替える。

１．Ascending
　　昇順に並び替える。

２．Descending
　　降順に並び替える。

>Random Network
選択された項目に従い、ランダムネットワークを生成する

<Total No. of arcs

verticeの数とarcsの数を聞き、有向線ランダムネットワークを生成する。
<Vertices Output Degree
　ネットワークの定義数（=頂点数）と与えられた距離の互いの頂点の出次数を反映した有向線ランダムネットワークを生成する。

　入力項目

①頂点数
②Min number of arcs from vertex

③Max number of arcs from vertex

④Multiplu lineを除くか？
<Erdos-Renyi

Erdos-Renyiのモデルに従い2-modeネットワークを生成する。
すべての潜在的なラインに含まれている顕在化する確率
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確率
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の代わりにもっと直感的なものに、以下の次数の平均が使われる。
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補足：グラフ
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それは、
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　*Undirected

　　無向ネットワークを生成する。頂点数と平均距離を聞いてくる。

平均距離：ある頂点がどのくらいの範囲の頂点とリンクできるかという距離の平均。平均距離が大きいほど完全グラフに近くなる。

　　　　　平均距離の最大値=完全グラフ

　　　1. General

         普通の形のネットワーク。
    　2. Bipartite

　　　　　2部からなるネットワーク。

    　3. 2-Mode

　　　　　2-mode。
  *Directed

　　　1. General

　　　　普通の形のネットワーク。
　　　2. Acyclic

　　　　Acyclicのネットワーク。

　　　3. Bipartite

      4. Acyclic Bipartite

<Scale Free

スケールフリーの無向、有向、無環ネットワークを生成する。

エンドポイントのエッジは以下の確率に従った値にランダムにすべての頂点間が選択される。
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　　そのとき、
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　　さらに、
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*Undirected

        入力項目
　　　　①頂点数

　　　　②ライン数

　　　　③平均距離

　　　　④Initial Erdos-Renyi graph:頂点数

　　　　⑤Initial probability of lines(0~1)

　　　　⑥Alpha (α)
      *Directed
　　　　①頂点数

　　　　②ライン数

　　　　③平均距離

　　　　④Initial Erdos-Renyi graph:頂点数

　　　　⑤Initial probability of lines(0~1)

　　　　⑥Alpha (α)

　　　　⑦Beta(β)

      *Acyclic

　　　　①頂点数

　　　　②ライン数

　　　　③平均距離

　　　　④Initial Erdos-Renyi graph:頂点数

　　　　⑤Initial probability of lines(0~1)

　　　　⑥Alpha (α)

      *Adding

        　・free
　　　　　　　「選択する」か「解除する」かのチェック項目。
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図：スケールフリーの設定Report
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図：以上の設定によって可視化されたグラフ

<Extended Model

アルバート・バラバシのExtended Modelを作る。
　　　入力項目
　　　①頂点数

　　　②孤立頂点の数

　　　　　
[image: image100.wmf]1
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のmを入力(1以上10個単位)
　　　③How many lines to add in each step

　　　④新しいラインを追加する確率(0~1)
　　　⑤リワイヤ（ラインの張替え）する確率

　　　⑥multiple lineを除去するか？
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図：Extended Random Network [3, 2, 0.333, 0.333] (1000)の頂点４からのパス数で

Partitionしたもの（Net>Partition>k-neighborのALL）。1000頂点のほとんどが2パスでいける（2パスの近隣）黄緑色であることがわかる。
>Partitions
ネットワークをPartition（クラス分け）する。出力は、*.cluファイルがメインスクリーンPartitionsボックスに出力される。
<Degree
　頂点の次数（Degree）でPartitionする。このように、頂点の次数によるPartition
　を便宜上「Degree Partition(次数によるパーティション)」と名づける。

PartitionsとVectorのボックスにファイルが生成される。

PartitionとVectorには、「Degree Partition」されたデータが入るが、

Partitionはクラスごとの色分け、Vectorは次数の多くなるに従い、頂点が大きくなるネットワーク可視化を担当する。
*Input
入次数によるDegree Partitionを生成する。
*Output
出次数によるDegree Partitionを生成する。

*All
　次数（入次数、出次数の区別なく）によるDegree Partitionを生成する。

[image: image102.png]



図：初期可視化状態のDegree Partition（ALL）の可視化例
色毎にパーティションされる。

次数と色の対応は、Partitionの色の対応設定に依存する。

Draw windowのOptions>Colors>Partition Colorsでみることが出来る。
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図：Circle－PartitionによるDegree Partition（ALL）の可視化例
次数でクラスわけされたPetitionごとに、円状に表示

クラスターを飛びえたリンクは、次数の違うもの同士のリンクとなる。

[image: image104.png]



図：kamada-kawai最適化によるDegree Partition（ALL）の可視化例
次数ごとに色分けされていることが確認できる。

　　*.cluファイルと共に、*.vecファイルも生成される。これは、次数が大きいほどVectorが大きい値をとるファイルである。
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図：Degree Partition（ALL）で生成されたVectorファイルによる可視化例

<Domain
　Domain：領域

　互いの頂点のため、入力、出力及びすべての隣接に従ったそれの領域を計算する。結果は、

1． 領域のサイズのPartition－頂点に到達できる数

2． 標準化された領域のサイズのVector－標準化は頂点の合計数を1にする。
3． 領域の~から~ までの平均距離のVector

の1つのPartitonと2つのVectorである。

近接誘因指標（Proximity Prestige index）は分けている標準化された平均距離の領域のサイズによって計算できる。

入力項目

①Maximal distance．distance (0-No limit)

0から限界数（頂点数）までの最大距離を入力。

*Input

*Output

*All

<Core
　Core（コア）には以下の3つが存在する。

　　１．K-Core：最大k個以上の次数を持つ最大サブグラフ

　　２．M-Core：Islandのこと（PajekではM-Coreといわず、Islandという。）

　　　　　　　　最大m以上のラインの値（重み）を持つ最大サブグラフ

　　3．P-Core：

　
　　　　　K-Coreは、処理的にいえば次数によるPartitionである。では、次数によるParitition（Degree Paritition）とはどこが違うだろうか？以下で明確にする。


[image: image106]以下のように考えるとわかる。つまり、K-Coreは水面下に入るものと水面上に出るものという風に考えることが出来る。上図では、次数3以下が水面下に（クラス番号1）次数4以上が水面上に（クラス番号2）出ると考えることが出来る。

　　　　　この水面の上か下かの基準kは、コンピュータによって自動で決定されえるため、Userは設定できない。


[image: image107]
さらに、最大サブグラフという制限があり、最大でないサブグラフの次数ｋ以上のサブグラフはすべて対象から除かれる。（クラス番号が1となる）


[image: image108]
つまり、以下のような処理過程となる。


[image: image109]
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図：K-Core(ALL)によるPartition可視化（kamada－kawai最適化）2-core
黄色：クラス番号１

黄緑色：クラス番号2

このネットワークの2-coreは黄緑色全体のサブグラフである。

（次数2のサブグラフでも、クラス番号2となっているところが散在するが、これは、Step2が存在しているためである。）

　　　　ちなみに、特定のクラス番号とそれ以外を0と1で区別するコマンドがある。Degree partitionをつくり特定の次数のみを1で表すことも出来る。

　　　　　　Partition>Binarize

　　　　　また、特定のクラス番号を別のクラス番号へと変換するコマンドもある。

　　　　　　Partition>Fuse cluster

　　　CoreとIslandの違いは、

　　　　　Core：次数に注目 

　　　　　Island：ラインの値（重み）に注目

　　　である。

*Input
　線が頂点の中に来るもの（入次数）

*Output
　　線が頂点から出て行くもの（出次数）

*All
　　頂点の隣接数（入次数も出次数も関係ないただの次数）

*2-Mode


[image: image111]
First subsetの最小次数の全頂点の集合：k1

Second subsetの最小次数の全頂点の集合：k2

　　　　　　　　処理手順

　　　　　　　　①k1とk2を作る
　　　　　　　　②k1とk2の頂点には、Partition番号0が割り振られる
　　　　　　　　③k1とk2以外の頂点にはPartition番号１が割り振られる
　　　　　　　　④Partition番号１のサブネットワークが2-ModeのCoreである
*2-Mode Review

k1、k2Rows Cols Compに従い処理

Comp：comprehensive
Comprehensive：包括的な

*2-Mode Border

Compute only border values of k1 and k2 for a given 2-mode network

与えられた2-modeのk1、k2を唯一のボーダーの値とした計算

<Valued Core

*First Threshold and Step

はじめに閾値を選び、閾値を上げていきながらステップする

聞いてくる値

①First threshold：

②Step(>0)：上昇させていく閾値のステップ


[image: image112]
　1. Input

　　入次数によるValued core

　2. Output

　　出次数によるValued core

  3. All

　　無向線によるValued core
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図：ALLでFirst threshold：1・Step：20の結果
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図：ALLでFirst threshold：1・Step：20の結果の可視化

*Selected Thresholds

Thresholds (increasing numbers) are given using vector

  1. Input

　2. Output

  3. All

*Use max instead of sum

<Depth
Depth：深さ、奥行き

*Acyclic

Acyclic：非環状の

Acyclicネットワークでないと受け付けないメニュー

頂点の奥行きに従った、AcyclicネットワークのPartition
*Genealogical
Genealogical：系図の
頂点のLayerに従った系図のネットワークのPartition
<p-Cliques

Clique：グラフ理論上で、すべてのノードが互いに直接的な紐帯で連結しているグラフ
クリークとは、つまり完全グラフのことである。


[image: image115]
P：number between 0 and 1（0から1）
p-Cliques：少なくとも、クラスター内に確率p（0~1）の近隣を持つ頂点を持つクラスターをPartitionする


[image: image116]
　　　　　つまり、確率1（100%）のp-cliqueは、完全にラインを引いたp-cliqueで、つまり、clique（完全グラフ）である。

　　　　　p-Cliquesに従い、Partitionする。Partitionボックスに*.clsファイルが生成される。
　　　　　入力項目

　　　　　　①確率

*Strong

for directed network（有向線を持つネットワーク）
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図：確率0.5のStrong p-Clique
*Weak

for undirected network（有向線を持たない、つまり無向線を持つ

ネットワーク）
[image: image118.png]B C:¥Documents and Settines¥sato keisuke¥5 25 k¥ testdataCRN.NET (327) / C4. Weak P-Cliques partition of N1 [0.501 G27) [ |[B][X]
Loyout Loyers GraphOnly Previous Redram Next Options Export Spin Move  nfo





図：確率0.5のWeak p-Clique

<Vertex Labels

同じ頂点ラベル=同じクラスとするPartition
<Vertex Shapes

同じ頂点の形＝同じクラスとするPartition
頂点の形＝.netで指定できる

<Islands
重さ：ラインの重さがあるネットワークの頂点のPartition

（Weight：Partition vertices of network with values on lines）

Islands：ラインの値（重み）による最大サブグラフ（別称：M-Core）

[image: image119]
Islandに似た概念であるCoreも同様で、y軸の「Line value(ラインの値・重さ)」の代わりに「頂点の次数」になる。

[image: image120]
*Line Weights
　入力項目

1 Islandの最小サイズ

2 Islandの最大サイズ

*Line Weights[Simple]
  入力項目

3 Islandの最小サイズ

4 Islandの最大サイズ

　　　　　*Generate network with Islands

             [選択項目]
<Bow-Tie

「Bow-Tie」のパーティション形式に従ったPartition。
1-LSCC
2-IN

3-OUT

4-TUBES

5-TENDRELS

0-OTHERS

[image: image121.png]



図：WebのBow-Tieグラフ[manual 18]
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図：Bow-Tie後に表示されるReport
　　　　　　有向線ネットワークを巨視的に見ると、bow-tieの形式となっている。

１、有向線ネットワークの中心部分

２、有向線ネットワークの中心部分へ向かう有向線部分
３、有向線ネットワークの中心部分から出て行く有向線部分

　　　　　　　４、2と3が中心部分を通らず直接つながっている部分
　　　　　　　５、1,2,3を関係なく流れが出来ている部分（支流）
0、 まったく孤立している部分

　　　　　　有向線ネットワークは、巨視的に見ると以上のように流れがある。1,2,3を本流として捕らえ、1を湖、4は湖を通らない流れ、5は支流、0は沼と捉えるとわかりやすい。
　　　　　　
　　　　　　では、実際どうなっているかを下記で見ていく。


[image: image123]
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図：Bow-Tie後に生成されたPartitionファイルで可視化したネットワーク

<2-Mode

2-Mode（2部グラフ）ネットワークの2つの部分集合（First subsetと Second

Subset)をパーティションする


[image: image130]
>Components
    Components：ネットワークの最大サブグラフ（1つ）である。


[image: image131]
　　入力項目

　　①Componentの最小サイズ
Components：最大サブグラフ
<Storng

選択されたネットワークの「Storng Components」
<Storng-Periodic
　選択されたネットワークの「Storng-Periodic Components」

強い結合のComponentsは、期間に従って分け進められる。

<Weak
　選択されたネットワークの「Weak Components」

<Bi-Components
選択されたネットワークの「Biconnected Components」

         結合点(Articulation points)は、幾つかのクラスに所属している。その結果は、Partitionに記録されない。Biconnected Componentsは、Hierarchyに記録される。Components内の頂点の最小値を選ぶ。それに加えて、Parititoinに属している結合点が生成される。互いの頂点に属したBiconnected Componentsの数が与えられる。Parititionは、正確なBiconponentsのParititionに所属している頂点により成り立っており、Biconponentsの外にある頂点と結合点は、共に、以下のものが生み出される。

Biconponentsの外にある頂点：クラス番号0
Biconponents：クラス番号1~ Biconponentsの数と結合点はクラス番号99999998を取る。

>Hierarchical Decomposition

<Clustering

階層的クラスター分類の手続き。入力は、異なるネットワーク（行列）で、それは、Operation>Dissimilarityかインプットファイルを読み込むことによって得られる。
*Run

階層的クラスター分類を作る。結果は、同種に集められた（nestされた）クラスターと、EPSに収められたデンドログラムを含む階層である。
*Options

階層的クラスターをつくる方法を選択する。
（general,minimum,maximum,average,ward.squared ward）

<Symmetric-Acyclic
ネットワークの相対的非環分解。結果は、同種に集められた（nestされた）クラスターを含む階層である。
>Numbering
　　Permutationに*.perファイルが生成される。*.perファイルは頂点の再配置（=頂点番号の張替え）であり、Numberingとは頂点の再配置するメニューである。


[image: image132]
<Depth First

Depth first numbering of selected network

*Strong

taking directions of arcs into account

有向線の方向を計算する

*Weak

forget directions(or undirected network)
　方向を考慮しない。つまり、無向線向け処理。

<Breadth First

Breadth=幅、広さ

Breadth first numbering of selected network

*Strong

taking directions of arcs into account

有向線の方向を計算する

*Weak

forget directions(or undirected network)

<Reverse Cuthill-McKee

RCM numbering=?

<Core+Degree
>Citation Weights

Citation=引用

　もしも、ネットワークがCitation networkとして表せるなら、ラインの値（重み）（つまり、Citation）と頂点（の一部）は以下を出力とした計算ができる。

　ラインの値（重み）：Citation

　結果は、

　　ⅰ）重要なCitationで表されたラインの値（重み）のついたネットワーク

　　ⅱ）メインパス上の頂点によるBinary(0か1)Partition

　　ⅲ）メインパスのみにより構成されたネットワーク

　　ⅳ）重要な頂点（の一部）のVector

重さは、標準化（使用されている流れか最大値）またはログをとることも出来る。
<Search Path count(SPC)

　非環状ネットワークでないと処理できない。水源から排水溝への計算を行う方法。

[image: image133]
Pathとは以下のように直線上につながったものである。

[image: image134]
<Search Path Link count(SPLC)
　　互いの頂点を水源として考慮した方法。

<Search Path Node pair(SPNP)

method.
>k-neighbors
　対象頂点（自分で選んだ）から最大ステップを指定し、どこまでの頂点までいけるか？

がわかる。

k-neighborsを選択した後の手順

　①対象頂点を選ぶ

　②最大ステップ数（k-step）を選択する

　③メインスクリーンPartitionボックスに*.vecが生成

　④Partitionと共に可視化（Draw>Draw-Partition）

　⑤下図のような可視化が出来る
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図：頂点2（水色）から4ステップ（最大値）でいける頂点

　　1ステップでいける－黄色

　　2－ステップでいける－黄緑
　　3－ステップでいける－赤

　　4－ステップでいける－青

　　この配色は、Partitionの色別設定に従う。

　　Options>Colors>partition Colors>for vertices

    で変更可能

　　可視化のとき、ctrl＋Nを押せば頂点番号、ctrl＋Lを押せばラベルが表示されて、

　　どの頂点まで到達するかがわかる。

　　（Options>Make Vertices Using）

k-neighbors：

Select All vertices…
<Input

最大k-stepの選ばれた頂点に届くことが出来る入次数の頂点を探す。

..form which we can reach selected vertex in at most k-steps

<Output

最大k-stepの選ばれた頂点に届くことが出来る出次数の頂点を探す。
..that can be reached form selected vertex in at most k-steps

<All

..Input+output

<From Clusters

計算は、選ばれた距離に従ったクラスター内の互いの頂点距離となる

>Paths between 2 vertices

2頂点間のパスに関して・・・
<One Shortest

2頂点間の最短パスを求める。
入力項目

1 From

2 To

3 Forget value of lines?(yes/no)

4 Identity vertices in source of network
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図：頂点番号30から50までの最短パス。

番号は、パス数である。新しいネットワークファイルとなっているため、Darwのみでは、どの頂点を通っているかはわからない。しかし、元のネットワークファイルと生成されたPartitionファイルを使って可視化すればどの頂点を通って最短パスを形成しているかがわかる。
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図：元ネットワーク内の30から120までの経路（黄色）

[image: image138]
<All shortest

すべての2頂点間の最短パスを求める。
<walks with Limited Length

最長レンジを探す。
入力項目

1 From

2 To

3 Forget value of lines?(yes/no)

4 Identity vertices in source of network

5 Input maximum length of walk allowed(>0)

<Diameter

Diameterを探す

Diameter：直径

最長最短パスを探す

Diameter：最長最短パス?

<Geodesics Matrices

small networkのみの処理！

Geodesics：測地線 ・最短パス長のこと
最短パスのマトリックスを計算する

そして測地線を計算したマトリックスを計算する

<Distribution of Distances

*From All Vertices

starting pointsのすべての頂点を取る

starting points：
*From Vertices in Cluster

クラスター内の頂点のみ

>Critical Path Method(CPM)
非環ネットワークでクリティカルパスを求める。結果は、クリティカルパスを含んだ新しいネットワークとなる。2つのVectorファイル（及びPartitionファイル）を生成する。1つ目のファイルは、早い時間の状態が記述され、2つ目のファイルは、遅い時間の状態が記述される。
>Maximum Flow

Maximum Flow amang vertices

複数の頂点について最大フローを求める

<Selected Pair

2頂点の最大フローを求める。（アルゴリズムは、直線のパスとそれらの周りのいつも選ばれる最短のパスを探す。）アルゴリズムは、テクニカルエリア（実際のフロー[actual flow]、許容量を意味するラインの値（重み））あるいは、分析的グラフ（すべてのラインが1のとき）を使う。
　入力手順

1 Find  maximum flowのfromの入力

2 Find  maximum flowのtoの入力
3 Forget values in lines?（ラインの値（重み）を忘れるか？）

4 Identify vertices in source network?（頂点を元のネットワークと見分　　　　　　　　　　　　　　　

　　　　　　　　　　　　　　　　　　　　　けるか？）
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図：30から60のSelected PairのMaximum Flowの例(15頂点、Flow=1.00000)
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図：元ネットワーク内での30から60のSelected PairのMaximum Flow
　　　　　　　

　　　　　　　生成されるもの

　　　　　　　ⅰ）新しいネットワーク（*.netファイル）

　　　　　　　ⅱ）Partitionファイル

<Pairs in Cluster

頂点の周りで定義されたクラスター間の最大フローを求める。結果で生成されるものは、ラインの値（重み）の意味が、一致した2頂点間の最大フローである新しいネットワークである。
　　　　　（アルゴリズムが遅いため、限定的な頂点の小さなネットワークのみである。）
>Vector

get vector from network
*.vecファイルを生成する操作（オペレーション）メニュー

<Centrality

中心性を求める。


[image: image141]
中心性とは
　　　　　　中心性（Centrality）とは、ネットワーク分析のための概念であり、ネットワーク内の任意の頂点がどれだけ中心にあるかの性質を示す概念である。その量的な指標を中心性指標という。

　　　　　中心性指標には大別して4つが存在する。

１、次数：ある頂点が所有している次数に着目し、次数が大きいほど中心性が高い

２、近接性：ほかの頂点とどれだけ距離が離れているかを示すもので、これが小さいほど中心性が高い

３、媒介性：その頂点を通過しないと到達できない頂点の数を表し、その数が大きいほど中心性が高い

４、固有ベクトル：どの程度ほかの頂点とつながっているかを示す。

　　　　　　　Pajekでは、「2、近接中心性（Closeeness Centrality）」と「３、媒介中心性（Betweenness Centrality）」を求めるメニューがある。この中心性を可視化も出来る。
１、次数中心性（Degree Centrality）
　　　　　　　　　　（pajekのメニューに存在する。）
次数中心性
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ネットワーク総頂点数Nとすると、
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任意の頂点の近接する頂点数（次数）と自身の頂点を除いた総頂点数の比で表される。

ある頂点の次数が高いほど、次数中心性が高い。つまり、次数中心性はハブ（あるいは、オーソリティ）に近い役割を果たす頂点を探すことである。
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２、近接中心性(Closenness Centrality)

頂点
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、頂点
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の近接中心性
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、ほかの頂点までの距離の総和（離心率）
[image: image151.wmf])

(

i

v

s

とすると、


[image: image152.wmf])

(

1

1

)

(

)

(

i

i

i

v

s

n

n

v

s

v

Cc

-

=

÷

ø

ö

ç

è

æ

-

=

−１


離心率が高くなるほど
[image: image153.wmf])
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が小さくなり、中心性が高くなる。離心率
[image: image154.wmf]e

を他の頂点までの距離総和
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　　　　　　　　　　つまり、定数
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という離心率の描き出す図は楕円である。
[image: image343.png]E2. Simple Random network [200] (100) / V1. Betweenness centrality in N2 (100)
Layout GraphOnly Previous Redran Next Options Export Spin Move Info





図：離心率[10]

離心率
[image: image158.wmf]e

の描く図形とは、図1.1の
[image: image159.wmf]定数）
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を満たすの図形のことであり、離心率=0は円で0<e<1は楕円である。つまり、円より楕円のほうが面積が大きいので、離心率が大きいとほかの頂点までの距離の総和が大きいと考えられる。
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近接中心性には、以下の式も存在する。

ある集団（コミュニティー）の総頂点数ｇ、ネットワーク内の任意の頂点
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、
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と同じコミュニティー内の任意頂点
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の最短距離
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[image: image169]

[image: image170]
この式は、他の頂点までの距離の総和（離心率）ではなく、任意頂点の最短距離から近接中心性を求める式である。式からわかるように、任意の頂点
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とその頂点のコミュニティー内の頂点
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n

の最短距離をコミュニティー内の全頂点で計測していく。その数が小さい（つまりほかの頂点との距離が近い）と
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が大きくなって、その頂点は中心性が大きくなる。gは、ネットワークの頂点数で、
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全頂点で計算するという意味である。前の式との違いは、前の式は対象頂点と別の頂点の距離の総和に着目したが、この式は最短距離に着目するという違いである。
３、媒介中心性（Betweennes Centrality）
　　　　　　　　　　　　　　（pajekのメニューに存在する。）


[image: image175]
また、ハブ・オーソリティのような頂点も、潰れてしまうと迂回路を通りWalkに大きなパス数を使う可能性が高くなるため、これらの頂点も媒介中心性が高くなる。つまり、最短パスの順路はハブ・オーソリティの数や集中度が高いほど、これらを通る確率は必然的に高くなるから、これらの媒介中心度は高くなる。

[image: image176]
　　　　　　　　　　　　上記から「次数中心性」との違いは明確で、媒介中心性の高い頂点の特徴(その1)より、次数中心性では考慮されなかった「ブリッジ」も中心度が高くなる。
媒介中心性
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間の最短経路上に存在する（媒介する）頻度
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、ネットワーク総頂点（ノード）nの２頂点間のうち
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の合計値 、媒介値
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この式は、総頂点nから2頂点
[image: image185.wmf]i
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と
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を除いたものと、総頂点nから頂点
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を除いたものの積と媒介値の2倍数
[image: image188.wmf])

(

2

k

v

BC

の比によって表される。
媒介中心性を他の表現をすると、

ノードi、媒介中心性Cb(i)、iを通るｊ、ｋ間の最短経路の数
[image: image189.wmf])
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、ｊ、ｋ間の最短経路の総数
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、ネットワークの総ノード数Nとると、
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（ネットワーク上に存在するノードペアの最短経路がどの程度ノードiを経過しているかの比で表現される（2004，松田）)

この式は、
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の式とは違い、媒介ノードを特定せずに、2ノード間の最短経路でいくつのノードを経過するかを計ることによって媒介中心性を求めている。

４、固有ベクトル中心性
以下の、ボナチッチ中心性（Bonacich Centrality）は、固有ベクトル中心性の代表的な手法である。

頂点
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、頂点
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が
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を指名する結合強度
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、頂点
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の中心性
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頂点
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の中心性
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の強さで結合する頂点
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の中心性
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多くの頂点とつながっている中心性の高い頂点との連結が、中心性を高くするという考え方で、数学的には隣接行列
[image: image209.wmf][
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を求めていることの他ならない．(2006，中村)
そのほかに、ポータルサイトのページランクのアルゴリズ　ムも、固有ベクトルによって、中心性を求める。以下のものが有名である。　　　　　　

・HITS アルゴリズム(1998，Kleinberg)
・PageRankアルゴリズム(1998，Brin & Page)
*Closeness

クロースネス中心性を求める

1.Input

2.Output

3.All

*Betweenness
　媒介（Betweenness）中心性

<Get Loops

ループベクトルを保存する。

[image: image210]
<Get Coordinate

xかyかzのCoordinateを取得する。一回ですべてのCoordinateを取得することも出来る。
　　　　　　*x

　　　　　　　xのCoordinate
　　　　　　*y

　　　　　　　yのCoordinate
　　　　　　*z

　　　　　　　zのCoordinate
　　　　　　*ALL

　　　　　　　すべてのCoordinate
図：xのCoordinateの例


[image: image211]
<Important Vertices

重要な頂点を見つける。
*1-Mode:Hubs/Autorities

1-modeネットワークのハブやオーソリティを見つける

ハブ：有向線グラフにおいて、出次数が他の頂点と比べて圧倒的に大きいもの

オーソリティ：有向線グラフにおいて、入次数が他の頂点と比べて圧倒的に大きいもの

オーソリティとハブのネットワーク内の意味は、

・ハブやオーソリティへの次数が高い（集中度が高い）

・ネットワーク内のハブやオーソリティの数が多い

ほど、ネットワークの平均パス数は大幅に減少し、伝播しやすくなり、つまり小さい世界（ネットワーク）になる。


[image: image212]
無向線の場合は、入次数・出次数の区別なく、主にエッジが集中している頂点はハブといっている。つまり、有向線のときのみ、オーソリティとハブと区別する。

[image: image213]
　　　　　　　入力項目
　　　　　　　　①How many hubs（ハブの数）

　　　　　　　　②How many authorities(オーソリティの数)

　　　　　　　以上の入力項目に従い、そのネットワークで定義されたハブ・オーソリティの数に従い、それらを探す。

　　　　　　出力は、Pertition：ハブやオーソリティとその他のノードのクラス分けと、vector：ハブやオーソリティの度合いの計算結果の2つが出力される。

*2-Mode:Important Vertices

最初の部分集合（Fiest subset）と2つ目の部分集合(Second subset)

の重要頂点を求める。
入力項目

1 How many important vertices from first subset

     (First subsetからの重要頂点の数)

2 How many important vertices from first subset

　　(Second subsetからの重要頂点の数)

<Structural Holes

burt's measure of constraint(structural holes)

constraint=強制・制約（条件）

burt's measure of constrain=バーツ値制約条件

Structural Holes=構造の穴（複数）

Vectorファイルが生成される。

Network
[image: image214.wmf]ij
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：クラス番号iとすべてのiの関係の数と比較したiと関係あるj
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：iからjへのラインの値（重さ）
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ネットワークに属していてる2項制約条件（dyadic constraint）
[image: image217.wmf]ij
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：

制約条件は、i上のj周りの1項の穴（Primary hole）が不在である。

　　　　　接点（contact）jは、あなたのiの以下の企業家の意見の範囲で制約されている。

a) あなたはエネルギーがjに届き、時間の大きな投資を作られた。
b) jはいくつかの投資に対する優位なリターン（黒字）をとるための交渉が出来ることがついたいくつかのStructural Holes（構造の穴）囲まれている。
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Vectorは制約
[image: image219.wmf]i
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の総量から成り立っている。
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孤立頂点は、
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図：Structural Holes

<Clustering Coefficients

Clustering Coefficients：クラスタリング係数
クラスタリング係数を計算する。（無向線ネットワークの）
無向線ネットワーク内にある違う固有の傾向の係数を計算する。
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：頂点のvの次数
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：頂点vの1-近隣（1-neighborhood）内にある頂点（vertices）の周りのラインの値（重さ）
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：頂点vの1および2-近隣（1-neighborhood）内にある頂点（vertices）の周りのラインの値（重さ）

　　　　　*
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　　　　　　　　1-近隣（1-neighborhood）のみを考慮した係数
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　2-近隣（1-neighborhood）を考慮した係数
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もし、
[image: image232.wmf]1
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ならすべての頂点vの係数(Coefficients)は0になる。
VectorとPartitionファイルが生成される。

<Summing up Values of Lines

頂点のつながったラインの入力出力をの合計値を出す。

[image: image233]
生成されるファイルはVectorのみ。（Partitionは生成されない）

　　　　　　*Input

　　　　　　*Output

　　　　　　*All

　　　　　　　Input+ Output
<Min of Valuesof Lines

頂点のつながったラインの入力出力をの最小値を出す。

[image: image234]
生成されるファイルはVectorのみ。（Partitionは生成されない）

　　　　　　*Input

　　　　　　*Output

　　　　　　*All

　　　　　　　Input+ Output

<Max of Values of Lines

頂点のつながったラインの入力出力をの最大値を出す。

[image: image235]
生成されるファイルはVectorのみ。（Partitionは生成されない）

　　　　　　*Input

　　　　　　*Output

　　　　　　*All

　　　　　　　Input+ Output

<Centers

robberyアルゴリズムに従いcentersを求める。頂点は（vertices）それらから盗まれたそれらの近隣より高い次数を持つ。
Centers：
はじめのとき、初めの濃度を頂点へと与えるときは、それらの頂点か値1での始まりに従う。
弱い頂点を見つけたときは、近隣はそれらの濃度に従ったから盗む、あるいは、それらは、同じ合計値から盗む。


[image: image236]
1 聞いてくること

2 Start with weighted values(degrees of vertices)?

3 Use weighted algorithm?
[image: image237.png]



図：Centerを求めた後の可視化

<Pcore

コアを求める。
core=k-core+m-core

m-core=それぞれの線がm以上の多重性を持つ最大サブグラフのこと

*Degree

ordinary cores
普通のコア。

[image: image238.png]



図：Core All

　1. Input
　　　入次数

　2. Output

　　　出次数

  3. All

　　　無向線

  4. Input+Output

　　　入次数と出次数との合算

  5. Max(input,output)

　　　入次数と出次数の最大値

*Sum
　ラインの値（重み）を考慮に入れる。（Pcoreの内側にあるラインの値（重み）を合計する。）
 1. Input

　　入次数

2. Output

　　出次数

 3. All

　　 無向線

4. Max(input,output)

　　入次数と出次数の最大値

*Max
ラインの値（重み）を考慮に入れる。（Pcoreの内側にあるラインの値（重み）の最大値をとる。）

  1. Input

　2. Output

  3. All

>Count

定義済み（pridefined)のリングに線がどれくらい属しているか

<3-Rings

3-ringの定義済みリングにどれだけ属しているか。*.netファイルが変更される。
     [image: image239.png]



図：ラインがCyclicかtransitive（Shortcut）の3-ringsに属している[mamu]
*Undirected
　　無向線ネットワークの3-ringの抽出。有向線ネットワークの3-ringと違い、3頂点にリング状にラインがリンクされているものが、無向線の3-ringである。

　　
[image: image240]

[image: image241]
*Directed
　　　　　　　　無向線ネットワークの3-ringの抽出。
<4-Rings

3-ringの定義済みリングにどれだけ属しているか。*.netファイルが変更される。
           [image: image242.png]



          　図：4-rings上の有向線の種類[manu]

*Undirected
　無向線ネットワークの4-ringの抽出。有向線ネットワークの4-ringと違い、4頂点にリング状にラインがリンクされているものが、無向線の4-ringである。


[image: image243]

[image: image244]
*Directed
　　　　　　　有向線ネットワークの4-ringの抽出。
　　　　　　ちなみに、ringには以下のような種類がある。ただ、3-ringと4-ringが一般的で、Pajekでもこの2種のみカウントできる。


[image: image245]
3.3Nets

２つのネットワークに関する処理。
1つ目(Main)のネットワークを『First network』といい、

2つ目のネットワークを『Second network』という。
主に、Second networkをFirst networkに追加するという処理である。


[image: image246]
>Union of lines

2ネットワークのラインを統合する


[image: image247]
>Cross-Intersection

選ばれた２ネットワークの交差させる

>Intersection
選ばれた2ネットワークを関係する数字のところで交差させる
>Cross-Differnce
選ばれた異なったネットワークを交差させる

>Defference
異なったネットワークのラインを引く。Union of linesと逆の操作。
>Union of Vertices

頂点を統合する

>Fragment(1 in 2)
　　　2-modeネットワークないで（1-modeネットワークによって定義された）すべての種類の断片を見つける。

<Find
　コマンドを実行する。

<Options

適当な断片モデルを選ぶ。
*Induced

　　　　　　　　
*Labeled

ラベルに一番合うもの

*Check Values of lines

*Check relaton number

*Extra subnetwork

サブネットワークの頂点は特定の断片やに含まれるかあるいは一致するか？

・Retain all vertices after extracting

*Same vertices determine one fragment at most

同じ頂点の集合のどの断片として扱えるか？

*Repeating vertices in fragment allowed

>Multiply First*Second 
選択された1-modeか2-modeのネットワークを増やす。
　　　　　選択された1-modeや2-modeはSecond networkのこと
>Shrink coordinates(1to2)
<Partiotion

<Hierarchy
3.4Operetions

one network and something else is needed as input

>Shrink Network
Shrink Network=縮むネットワーク？

ネットワークを縮ませるオペレーション？

Shrink Network=ネットワークの種類（IN　Bolockmodel?)

<partition

<hierarchy

>Extract from Network
　　サブネットワークを以下の対象から引き出す処理
<Partition
サブネットワークをPartitionに従い引き出す。（Partitionのクラスのrangeを引き出す。）
　　　　Partitionファイル(*.clu)ファイルがあらかじめないと、処理を受け付けない。

　　　　　入力数字

1 クラス番号

このクラス番号のネットワークをサブネットワークとして抽出する。

　　　　処理のアウトプット

　　　　　①*.netに生成されたサブネットワークが入る

　　　　　②*.cluには、選択されたクラス番号のみのPartitionが入る

<Cluster
　選択されたクラスターからサブネットワークを引き出す。

<to GEDCOM
　新しいGEDCOMファイルに選択されたParition（Weakly connected component）から生成された、サブ系図(sub-genealogy)を入れる。
>Brokerage Roles
   partitionファイルが必要

　Brokerage：仲買、仲介

　Brokerage Roles：
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図：Brokerage Roles[Reference Manual]

 処理すると、以上の5種類のBrokerage RolesのPartitionファイルが5つ生成される。


[image: image249]
>Dissimilarity
    Dissimilarity：差異性（=類似性）
    共通の近隣の値にしたがったクラスター内の頂点間の選択されたDissimilarity Matrix－つまり類似性行列（
[image: image250.wmf]4

3

2

1

,

,

,

d

d

d

d

）を計算する。Corected Euclidean-like 
[image: image251.wmf]5

d

Manhattan-like
[image: image252.wmf]6

d

の類似性も同様に計算する。
　　

　　頂点が入っているクラスターファイル(*.cls)が必要。

[image: image253.wmf]v

N

：入次数、出次数あるいは普通の次数（入出無関係の次数）の近隣の頂点vの集合

＋：システム的加算


[image: image254.wmf]È

：和集合


[image: image255.wmf]\

：差集合

｜：集合の濃度
1st maxdgree,2nd maxdegree：最大次数と2番目の最大次数

頂点vのそれ自身の近隣を含めるか含めないか、また、（もし、頂点の値が低いなら）Upper triagle（無向線ネットワーク）か完全行列（有向線ネットワーク）をレポートウインドウに表示できる。

Corected Euclidean-like 
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Manhattan-like
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は、いくつかの頂点上の行列
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　　　　<d1
1. Input

2. Output

　　　    3. All
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図：Dissimilarity d1処理後のレポート
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[image: image263]
<d2

1. Input

2. Output

　　　    3. All

        <d3

1. Input

2. Output

　　　    3. All

        <d4

1. Input

2. Output

　　　    3. All

        <d5-corrected Euclidean

        <d6-corrected Manhattan

        <Option
>Vector
    ネットワークとVectorに関する処理。
<Network*vector
　普通のVectorの行列（ネットワーク）の掛け算。結果は、新しいVectorである。
　　入力手順

　　　①Number of repetition（反復回数）

<Vector#Network
　結果は、新しいネットワークである。

*Input
　Vectorの値と一致するネットワーク内の入有向線の掛け算。

　i次（i-th）のVectorのコンポーネントとi次(i-th)の行列の列を掛ける。

*Output
　Vectorの値と一致するネットワーク内の出有向線の掛け算。

　i次（i-th）のVectorのコンポーネントとi次(i-th)の行列の行を掛ける。

<Harmonic Function
　Harmonic Function：同調関数

　
[image: image264.wmf])
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G

：重さ関数（Weight functioin）
[image: image265.wmf])

,

(

y

x

a

を持った結合した重さグラフ

　　　　　（Connected weighted graph）

  S：頂点
[image: image266.wmf])
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の部分集合

　もし、
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[image: image270.wmf]R

g

V

f

®

)

(

:

は、境界(Boundary)Sを持つ(G,a)上の同調(Harmonic)という。
Pajekでは以下を実行する。

・関数fはVectorによって定義づけられる。
・重さ関数
[image: image271.wmf])
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a

G

は、（数値化された）ネットワークによって与えられる。

・部分集合Sは、Partiitonによって定義づけられる。クラス1の頂点は、（頂点と合う）部分集合Sに入れられ、他の頂点は
[image: image272.wmf]S
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に入れられる。
・追加的に、Permutattionはコンピュータ上の頂点のオーダーによって定義づけられる。

*Input
　入力近隣

*Output
　出力近隣

*All
　入力出力を区別しない近隣

<Summing up neighbors

*Input

*Output

*All

<Min of neighbors

*Input

*Output

*All

<Max of neighbors

*Input

*Output

*All

<Put Loops

<Put Coordinate

<Diffusion Partition

<Islands

*Vertex Weights

*Vertex Weights[simple]

>Transform
  　 ネットワークを、Partition、Cluster、Vectorに従い変形させる。以下のようなコマンドによって変形させる。
<Remove Lines
　Partition（*.clu）に従い、ラインを消去する。

*Inside Clusters
　選択された同じクラスター内の頂点のラインを消去する。


[image: image273]
*Between Clusters
　異なったクラスター間の頂点のラインを消去する。


[image: image274]
*Inside Clusters with value

1.lower than Vector value

2.higher than vertor value

<Add

*Arcs from Vertex to Cluster

*Arcs from Cluster to Vertex

<Direction

*Lower->Higher

*Higher->Lower

<Vector(s)->Line values

>Reorder
   再配列(Reorder)する。再配置には、Permutationファイル（*.per）を使用する。
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図：*.perのメインスクリーンのEditの表示の例

頂点１は頂点102へ、頂点２は頂点35へ再配置される。

<Network
　Network(*.net)ファイルの頂点を、選ばれたPermutationに従い再配置する。

<Pertition
　Partition(*clu)ファイルの頂点を、選ばれたPermutationに従い再配置する。

<Vector

　　　　　Vector(*.vec)ファイルの頂点を、選ばれたPermutationに従い再配置する。
>Count neighbor Colors
      PartitionとClusterが必要。選ばれたネットワークとPartitionのための新しいParititonを、近隣の選ばれた色を与えた頂点の確率的な互いの頂点のところに生成する。色は、定義されたクラスターファイルにより計算される。
>Coloring
<Create New
　　Permutation（頂点の再配置のためのファイル）によって秩序付けて定義された頂点の『経過的な』色付け。Paermutationファイルが結果に依存する割合はかなり高い。
<Complete Old
　　Permutation（頂点の再配置のためのファイル）によって秩序付けて定義された頂点の『完全な』色付け。例えば、手によって幾つかの頂点が色づけされたとしても、大半の頂点はいまだに色づけされていない頂点である。（クラス0）。この方法は、適当な色分けを支援してくれるコマンドである。
>Balance

　　　符号付のグラフPartitionを行うためのアルゴリズム。（+、－のラインの値（重み）は、友と敵を表す。）ハイダーのバランスモデルのことである。

　　　　3者間の関係を+（よい）－（悪い）で表した図のモデル。－の悪い関係が偶数のとき、バランス（均衡）し、奇数のときは均衡が崩れ均衡しようとするモデル。


[image: image276]
　　　　　この3角形を基本として、大きなネットワークを形成させることも出来る。
>Blockmodeling
　　ブロックモデルを生成する
<Randam start
　ランダムPartitionによる最適化を始める
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<Optimize Patition
　選ばれたPartitionやその最適化の（判断）基準を表示する。

<Restricted Options

 　　　　
>Genetic Structure
　与えられたPartitionに従った、与えられた非環状ネットワークの発生の構造を計算する。

>Permutation
　　与えられたPermutationをネットワークに従い改善する。
<Travelling Salesman

*Rum

*Options

<Seriaton

*1-mode

*2-mode

<Clumping

*1-mode

*2-mode

<R-Enumeration

>Functional Composition
　　ｆ：partitionかpermutation

g：partitionかpermutationかvector

     r：r=(f＊g)[v]=g[f[v]] によって生成されたpartitionかpermutationかvector
>Expand Parition
<Greedy Partition
　　頂点と共に不明なクラスを0と置く。
*Input

*Output

*All

<Influencce Partition

<Make Multiple Relations Network
>Expand Reduction
　　階層による削減によって削減されたネットワークと適当な階層（いつも無向ネットワーク）を再記録する。
>Identify
　　Identify(reorder and/or join some units)
>Petri
    ペトリネットを生成する。Partitionファイルが生成される。

　　ペトリネット：コンピュータの並列処理を表すモデル図

[image: image278.png]



図：Petri net[manual]
<Random

<Complete
>Refine Partition
Refine：精製［錬］する, 純化する ; 洗練する、改善する

選ばれたネットワークに従いPartitionを改善する。
<Strong
　有向ネットワーク

<Weak
　無向ネットワーク

>Leader Partition
　　　層のかなにあるネットワークの頂点のクラスターを見つける。

　　　層・階層（layer）：
　　　Leader：指導者、指揮者、【コンピュータ】先行部分、【印】（pl.） リーダー ((点線や破線)); 導管
3.5Partition

>Create Null Partition
　　頂点数を定義（Dimension）して、Null Partitionを生成する。Null Partitionとは、クラス番号がすべて0のPartitionである。
> Create Random Partition
　　頂点数とクラス数を定義（Dimension）して、Random Partitionを生成する。Random Partitionとは、クラス番号がすべてRandomに割り振られたPartitionである。
>Binarize
　　選ばれたPartition(*.clu)をBinary（0か1）のPartitionにする。選択されたクラス番号を1に選択されなかったものをすべて0にする。よって、このメニューを実行する前に、Partition(*.clu)がPartitionボックスに入っていなければならない。
　　　
[image: image279]
　　　　特定のクラス番号のクラスターを抽出することが出来る。
>Fuse Clusters
　　選ばれたPartition(*.clu)の選択されたのクラス番号を、別のクラス番号にする。
　
[image: image280]
>Canonical Partition
　　Partitionから特徴的な（Canonical）Partitionを生成する。特徴的なPartitionのルールは、

　　1)頂点1はクラス（番号）１

　　2)頂点1のクラスより次の頂点が小さい数ならば、頂点1はクラス（番号）２へ

　　3)繰り返す
>Canonical Partition[Decreasing frequencies]
　　　Partitionから特徴的な（Canonical）Partitionを生成する。特徴的なPartitionのルールは、

　　1)クラス１は最大頻度の集合の古いクラス

　　2)クラス2は2番目の頻度の集合の古いクラス

　　3)繰り返す
>Make Network
　　　選ばれたPartitionによるネットワーク生成。
<Random Network

*Undirected

*Input

*Output

<2-mode network

>Make Permutation
　　　選ばれたPartitionによるPermutation生成。
>Make Cluster
　　　選ばれたPartitionによるCluster生成。
>Make Hierarchy
　　　選ばれたPartitionによるHierarchy生成。
>Make Vector
　　　選ばれたPartitionによるVector生成。
>Coun,Min/Max vector
　　　　以下の情報

　　　　①クラスターの頻度

　　　　②Partitionによって与えられた最大、最小のVectorの値
3.6Pertitions
　　2つのPartitionファイルの処理。

[image: image281]
>Extract secound from first
　　Second boxで決定された基準（特定の数値間）を満たすFirst boxの頂点を引き出す。この処理は、実際に頂点について様々な情報が保存されたPartitonを持っているとき役立つ。（例：ジェンダー=性の情報を持つPartition）幾つかの最短パスを持つとき（例えば、選ばれた頂点から3パス以内の距離の頂点）、ジェンダーの情報は、Partition上の処理を実行することなしに失う。
>Add partitions
　　2つのPartiotnを追加する。（例えば、非環上ネットワークのInputとOutputの近隣が結合しているときに役立つ。）
>Fuse Partitions
　　2つのPartitionを融合させる。First boxのpartitionの後ろにSecond boxのpartitioinをつなげる。
>Expand
　　より高い（元の）定義数のPartitionを上昇させる。
<First according to secound(Shrink)
　First boxのPartitionを、Second boxのPartitionが縮小していくものにしたがって上昇させる。
<Insert First into Secound according to Third(Extract)
　現在のPartitionは、First boxからSecond boxに定義された選択されたクラスを引き出すことによって得られる。このSub-Patition（部分Paritiion）は修正されたものである。この処理を使用するとき、この修正されたSub-ParitiionをFirist boxのPatitiionの後ろに挿入することが出来る。

>Intersection
　　2つのPartitionを交差させる。
>Make Random Network
　　以下のランダムネットワークを生成する。

　　　1)入次数の定義はFirst partitionのデータに従う
　　　2)出次数の定義はSecond partitionのデータに従う
>Info
    2 partitionの情報を表示する。
<Cramer's V,Rajski
　Cramer's V,Rajski係数を計算し、レポートする。

<Spearman Rank
　相関係数

3.7Vector

Vector：ベクトル

ベクトルを使った作業を行うためのメニューである。ただし、Vectorは有向線でなく、このデータ構造は、頂点半径にフィードバックされることに注意する。つまり、ベクトルの値が大きいほど頂点の半径が大きくなる。また、ベクトルの値は頂点によって属性とされている値である。これは、以下のように考えられる。頂点の持つベクトルの値は、頂点に入ってくるベクトルの量であり、ベクトルの量（入ってくるベクトルの多さ）が大きいほど入ってくるものが多いため頂点が大きくなる。

[image: image282]
　出て行くベクトルは無関係であることに注意
また、“無向線（edge）でもこの値は成立する。”

[image: image283]
　入ってくるベクトルは、

　注意点：Vectorは上記のようにきれいに決定するものでなく、Vectorが頂点に入っていく量を無視して“独立に決定することが多い”。1つしか入っていないのに値が大きく、たくさん入っているのに値が小さいこともある。


[image: image284]
　もともと、これらの概念は抽象的であり、対象とする実ネットワークの意味からこれの解釈を考える。ある地域の交通網ネットワークを解析したのなら、そのネットワークの入ってくるベクトル（道路）が小さいのに頂点（交差点）ベクトル量が大きいなら、その頂点に入るベクトルは交通量が膨大な道路であるという解釈が出来る。

>Create Identity vector

Dimention of Vectorを入力する。

値１のVertexが入力した値だけベクトルファイルに生成される

>Extract Subvector

Partitionファイルが存在しないとエラー発生する。

基準は選んだパーティションの種類。
サブベクトルをベクトルから引き抜く。
>shrink vector

ベクトルの値が減少する。
>Make Partition

PartiitonにVectorをコンバートする。
<by Intervals

適当なクラス番号をとった選ばれた分かれている等しいベクトル頂点と値は、適当なクラス番号を取る。
間隔は取る（削除する）ことが出来る。
*First Threshold and Step

*Selected Thresholds

<by Truncating(Abs)
>Make Permutation
　　VectorからParmutationを作成する。
>Transform
　　Vectorファイルを変形させる。
<Multiply by
　　連続的に加算する。

<Add Constant
　　Vectorの値を連続的に加える。

<Absolute
　　値の絶対値をとる。
<Absolute+Sqrt
　　2乗根の絶対要素

<Truncate
　　Vectorの値の切捨て

<Exp
　　Vectorの値の指数

<Ln
　　Vectorの値の自然対数。

<Power
　　Vetorの値のべき乗
<Normalize
　　Vectorの値の標準化

*Sum
　合計値を1とする標準化

*Max
　　　　　　最大値を1とする標準化
3.8Vectors
2つのネットワーク（２つの*.netファイル）のvector処理に関するメニュー

>Add Vectors

2つのVectorファイルを一緒にする

>Subtract Second from First
　　FirstからSecondを引く
Difference of selected vectors

>Multiply Vectors
　　Vectorsを増やす。
product of selected vectors

>Divide First by Second
　　2つのvectorファイルを分配（分類）する。
>Linear Regression
　　2つのVectorファイルを線形回帰にフィットさせる。
>Min(V1,V2)
　　選ばれたVectorの少ない要素。構成は、Min(V1,V2)。
>Max(V1,V2)
　　選ばれたVectorの大きい要素。構成は、Max(V1,V2)。
>Fuse Vectors
　　2つのVectorファイルを融合する
>Transform
2つのVectorを他の２つのVectorへ変形する。
<Cartesian->polar

直交座標から極座標

<polar->Cartesian

極座標から直交座標

>Info

3.9Permutation
Permutation：順序の変更, 交換; 【数】順列;
ネットワークにおけるPermutationとは、そのネットワークの頂点を入れ替える（renumbering）することである。

頂点を入れ替えるとは、頂点番号（ノード番号）を入れ替える。いままである頂点のあったところに別の頂点との入れ替えが起こる。

メインスクリーンのPermutationメニューに*.perファイルが生成される。
*perファイルのデータ構造は、

*Vertices ノード数

１~nのノード番号（n行１列）
となっている。

*.netファイルのVerticesデータ部分のノード番号を変更するためのものである。
メインスクリーン上のEditボタンを押すと、Editサブテーブルが

『ノード番号　新ノード番号-新ノード番号』
という形で表示される。

ダブルクリックでノード番号が変更可能。
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*.perファイルを生成する際に、Demention（*.perファイルに写したい頂点番号の範囲）を指定する。対象*.netファイルの頂点数より少ない値を指定すると、指定した頂点番号までを、*.Perファイルへ書き込み、それ以外の頂点は無視される。
このときの*.perファイルの構成

『ノード番号.　新ノード番号』
となる。

>Identity

*.netの*Vericsの頂点番号と同一の頂点番号の*.perファイルが生成される。
>Random

*.netファイルの頂点番号をランダムに並び替えた頂点番号が*.perファイルに書かれる。
>Random 2-mode
2-Mode（２部グラフ）ネットワークの頂点番号を頂点数をDeimenton（定義）されただけ、ランダムに並び替えた*.perファイルが生成される。
>Inverse

逆順=Inverseにする

それは下記>Mirrorで実現できる

Inverse：

データ構造に変化なし

どのような意味があるのか

>Mirror

鏡に映したように、逆順に並び替えた(sort)*.perのデータ構造となる。

[image: image290]
>Make Partition

入力項目

①Number of Clusterと聞いてくる

（Between 頂点番号1 and 頂点番号最大値と入力値が制限される）
どの数だけクラスターを作るかということ

Permutationのデータ構造に変化はない。だが、Partitionメニューに*.clsファイルの生成される。

[image: image291]
つまり、Permutation（*per）のデータ番号（頂点再配置）からPartition(*cls)のクラス番号を生成する。
[image: image345.png]
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>Make Vector

*.perのデータがそのまま*.vecとなる。データ構造は.perと同様なので、拡張子が変わるだけとも取れる。

[image: image294]
3.10Cluster

メインメニューのClusterボックスに*.clsを生成する。
>Create Empty Cluster
　　何の情報もないクラスターを生成する。Editで手動かつ自由にクラスターを形成するためのファイル。
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PertitionファイルとEditウインドウが同じ構成だが、意味がまったく違うことに注意する。
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>Create Complete Cluster
　　　入力された定義数に従い、.netファイルから定義数だけの頂点番号の頂点を、クラスター化する。
　　　　　入力項目

　　　　　　①定義数（どれだけの量の頂点をクラスター化するか） 


[image: image299]
>Make Partition

クラスターをパーティションに変形する。
　　Partitionの定義数を入力する際に、対象の,netファイルの頂点数と同じ数でないと、可視化できないことに注意。

　　手順

①*.netの頂点数と同じ数のPartition定義数を入力。

②クラスターに属している頂点をクラス番号1になる。
③クラスターに属していない頂点をクラス番号0になる。

④可視化したときに、色別でクラスターとクラスターでないものがわかる。


[image: image300]
[image: image301.png]



図：35のComplete clusterのPartition化による可視化

　　　　頂点番号1~35（Complete cluster）がそれに属していないも頂点と別の色（つまり別のクラス番号）となっていることがわかる。
>Binarize Partition
　　上記と同様に、クラス番号を0か1にしたClusterのPartition。ClusterとPartitionが必要。
3.11Hierarchy
このメニューは、すべてHierarchyファイル（*.hie）を使用し処理する。つまり、Hierarchyファイル（*.hie）がないと処理できない。

>Extract Cluster
　Hierarchyからclusterを引き出す。

>Make Network
　HierarchyからNetworkを作成する。

>Make Partition
　HierarhyからPartitionを作成する。

>Make Permutation
　HierarchyからPermutationを作成する。
3.12Options

>Read/Write
　　　以下の設定を行うためのコマンド。

[image: image302.png]B options

Riead / Save Options

Thieshold 00000
Ma. vertces to draw |-10000

Fiead / Save vertces labels?
Gave cacrdnates of varises?
Save complete vertex descriplion?

Check equaltyof verter descriplins by reading?
Check equalty of ine descriptions by reading?

Auto Report?
Ore: 1:Male, 2Female frks.
GEDCOM - Paraph
Bipartte Paraph
Foraphsisbels
x/0=

0/0=

<

i e B B O B

993959.00000
993959.00000





図：Options>Read/Writeの設定画面
<Threshold

Threshold：しきい値
与えられた2頂点間のGenerate lineよりも高い（絶対に）ラインの値

<Max.vrtices to draw
ネットワークで最大値をもつ頂点に従った視覚化。
<Read/Save vertices labels?
　頂点のラベル、座標、その他の描写に関わることを読み込むか読み込まないかの指定。大規模なネットワーク・ラベルの長さが長い場合、これらが読み込もうとすると、これらの読み込み処理が非常に遅くなってしまう。読み込み処理の速度の遅延を防ぐためにこの設定をはずすことが可能である。

　

　また、ある.Netファイルの頂点のラベルを、別の.Netファイルの頂点のラベルから上書きすることも可能である。

　　Net>Transform>Add>Vertex Labels form File

<Save coordinates of vertices?
頂点座標を、読み込みするかしないかの設定。
<Save complete vertex description?
完全な頂点の描写（例：形、時間、間隔など）を読み込むかしないかの設定。
<Check equality of vertex descriptions by reading?
　大規模ネットワークの可視化の処理速度向上のために、頂点の描写を変える。

　チェックする：空間を同じ頂点の描写ときも、しばしば繰り返して読み込む。（例、頂点の形）

　チェックしない：時間を読み込むときそれらの描写が違うとき、時間を読み込む。（例、現ネットワークのタイムスタンプ）

<Check equality of line descriptions by reading?
　大規模ネットワークの可視化の処理速度向上のために、ラインの描写を変える。
　チェックする：空間を同じラインの描写ときも、しばしば繰り返して読み込む。

　　　　　　　　（例、点線か実線かのパターン）

　チェックしない：時間を読み込むときそれらの描写が違うとき、時間を読み込む。（例、現ネットワークのタイムスタンプ）
<Auto Report?
テキスト形式のレポートをrep1.repファイルに自動で書き込む

<ore:1-Male,2-Female links
Oreグラフという系図を読み込んだとき、2種類の異なった有向グラフが生成される。

1の値を持つ有向線は、父から子へという関係を持つ。
2の値を持つ有向線は、母から子へという関係を持つ。

<GEDCOM-Pgraph
　　　　　系図を読み込むとき、pgraphのフォーマットを使う（ノードはカップルか個人的か）

<Bipartite Pgraph
　　　　　個人的なマリッジ、トライアングル、サークルというスクエアを持つ、2部pグラフを生成する。

<Pgraph+labels
　　　　　GEDCOMファイルを読み込んだとき、pgraphのラインのラベルもまた取り付ける。
<x/0
　　　0と0でないものを分離したとき結果を指定する。
<0/0
　0と0を分離したとき結果を指定する。
>Blockmodel
　　縮小されたブロックモデルの型を選ぶ。

>Ini file
　*.ini：pajekの構成が保存されているファイル。

　　　　Optionで設定された変更点を保存する。
<Load
*.iniファイルを読み込む。

<Save
*.iniファイルを書き込む。
>Fontsize
　フォントサイズを変更する。

3.13Info

読み込まれた各種ファイルの情報（Information）を表示する。
Editで情報を表示することとの違いは？

>Network
ネットワークに関する情報（*.netファイルのデータ）の表示。
<General

*number of vertices
　　頂点数を表示する。

*number of arcs,edges and loops
　　有向線、無向線、ループの数を表示する。

*density of lines

ライン（Edge、Arce）の濃度を表示する。
*sort lines according to their values (ascending or decending)to find the most/least important lines

<Line Values

<Indices

Indices=?

<Triadic Census

Triad：3ノード間のラインの状態

Triads：Triadの種類をすべて（16種類）集めたもの
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図：Trads[manu]

Triadsの記号

『タイプ番号－3つの番号』
　　　　　3つの番号の意味は、

　　　　　　『（有向線が張られていない間隔数）（有向線の数）（両向有向線の数）』

同じ3つの番号で別の種類のTiadsは、最後にアルファベットの記号を付ける。

処理すれば、Vectorsメニューにファイルに以下の2つの*.vecが生成される。
このvectorファイルで可視化することは出来ない。なぜなら、データ数は必ず16であり、ネットワークサイズと合わないし、可視化を前提にしていない。
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図：Report

<Multiple Relations

　　　　　　　以下のネットワークの要素に関するReportを出す。
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図：Multiple RelationsのReport

<Vertex Label->Vertex Number

頂点を指定、あるいはラベルを指定する。

入力された値に従い、頂点とラベルの情報がサブウインドウ上に表示される。
>Perrition
　　


[image: image309]
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>Hierarchy
Hierarchyに関する情報を生成する。

>Vector
Vectorに関する情報を生成する。

　　サブウインドウでの表示

>Memory
使用マシンのメモリに関する情報。
>About
PajekのCopyrightやVersionに関する情報。
3.14Tools

>R
<Send to R

<Locate R

>SPSS
<Send to SPSS

<Locate SPSS

Pakekのフォルダに、SPSSのシンタックスファイルとして書き込まれる
>Web Browser
Vertexをシフトか右クリックをするとwebブラウザーが開かれる

>Add Program
ツールメニューに特別なプログラムを実行する項目を追加する

>Edit Parameters
追加された項目のプログラムをエディトする

>Remove Program
追加された項目を消す

3.15Draw
　　・*.net

・*.cls

・*.vec（2つを使用する場合もあり）

の3つのファイルを適宜利用して可視化する
>Draw
　*.netを可視化することが出来る。
>Draw-Partition
　Partition(*.cls)ファイルに従った、頂点がどのクラスに属しているかを、クラスごとに色分けして可視化できる。

>Draw-Vector
　Vector(*.vec)ファイルに従った、頂点の大きさを*.vecの値に反映させて可視化できる。

　ネットワーク(*.net)の頂点数と*.vecの定義数が等しくなければならない。
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図：Bitweenness中心性を計算したVectorファイルを反映した可視化の例

中心性の高い値ほど頂点が大きくなっていることがわかる。

>Draw-2Vectors
　2つのVector(*.vec)ファイルに従った、頂点の大きさを*.vecの値に反映させて可視化できる。

　メインスクリーンのVectorボックスの1番目に入っている*.vecは頂点の幅になり、
　2番目に入っている*.vecは頂点の高さになる。
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　上図の場合は、2.All closeness centrality in N1(327)のデータが、頂点の幅、

１.Betweenness centrality in N1(327)が頂点の高さとして頂点のサイズが変更される。
>Draw-Partition-Vector
　Partitionのクラスごとの色分けと、Vectoeの頂点サイズの変更を同時に行う。
>Draw-Partition-2Vectors
　Partitionのクラスごとの色分けと、2つファイルのVectoeの頂点サイズの変更を同時に行う。

>Draw-SelectAll
　Null-Partitionを使ったネットワークを可視化する。
4.Drawウインドウツールバー上の各種メニュー
4.1Layout

>Circular
円状に頂点を配置する。
1.Original

普通の円状の配置
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2.Using Permutation
Permutationを反映した円状の配置
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図Randam permutationによる可視化

3.Using Partition
Partitionによって、クラスター毎に分離する円状の配置
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図：次数によるPartitionの可視化

4.Randam
頂点を円状ランダムの配置する
>Energy
　自動的にネットワークのレイアウトを生成する。

1.Kamada-kawai
　頂点の配置の自動レイアウトのためのアルゴリズム
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図：座標を反映した配置
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図：同じネットワークで、Kamada-kawaiアルゴリズムで最適化した可視化

(a)Free
　配置可能なすべての位置

(b)Fix first and last

最初から最後までの頂点が画面の角に一致するように

(c)Fix one Vertex in the middle
選んだ頂点が中心（Middle)に来るように

(d) Selected group only

　　　　Partitionから選んだ頂点のみ
(e) Fix Selected Vertices
　選んだ頂点に合うように

partition(.clu)を読み込んだ視覚化のみメニューに出てくる

2.Fruchterman Reingold

Kamada-kawai以外の自動レイアウトのためのアルゴリズム

(a)2D

Optimization：

2次元空間（Plene）に置く
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球状に配置されている。Spinしてみるとわかる。

Spin>Spin around>スピンしたい角度
あるいは、ScrollBarを表示して回転させる。

Option>ScrollBar On/Off
(b)3D

3次元空間（Spece）に置く
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 (c)Factor
　Fruchterman Reingold最適化(optimization)を使っているとき、頂点間の最適な距離のための要素の入力

3.Srarting Positions
  エネルギー描写（energy drawing）のための初期配置

>Eigen values

Lanczosアルゴリズム

Eigen-=固有の

固有値、固有ベクトルを用いた描写（Lanczosアルゴリズム）

ラインの値を計算するかしないかもできる？

1.111
2つか3つの固有値を選ぶとアルゴリズムは符合している固有ベクトルと計算される

(a)111

はじめに符合した固有値の3つの固有ベクトルを計算する

(b)112

はじめに符合した固有値と2番目に符合された1の２つの固有ベクトルを計算

(c)122
　はじめに符合した固有値と2番目に一致する2の1つの固有ベクトルを計算

(d)123
　はじめに一致した固有ベクトル、2番目に一致した1と3番目の固有値に一致した１を計算する。

(e)11
　2つのはじめの固有値に一致した固有ベクトルを計算する。（2次元描写）

4.2Layers

pertition(.clu)を読み込んだ視覚化のみメニューに出てくる。
>Type of Layout
2Dか3Dのいずれの表示にするかを決定する。

2D－x,y

3D－ｚ

>In y direction
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>In y direction+random in X
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>In Z direction
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立体状に配置されている。Spinしてみるとわかる。

Spin>Spin around>スピンしたい角度

あるいは、ScrollBarを表示して回転させる。

Option>ScrollBar On/Off

>In Z direction+randam in xy
　　Z方向へ、xとｙをランダムにして表示する。

[image: image323.png]oot Laysrs Grapnonly Provous Roran Next_ Optiane Bxport Spn Movehio
. : A
[ 1 ﬂ' £
I o A
e
LS





>Averaging x coordinate
>Averaging x and y coordinates
>Tile in x direction
>Tile in xy plane
>Optimize layers in x direction
>Optimize layers in xy plane
>Resoluttion
4.3GraphOnly
ラベルやアローを取り除いた可視化ネットワークを表示する。

4.4Previous

　前に表示した可視化ネットワークを表示する。

4.5Redraw
　可視化ネットワークを再描写する。

4.6Next
　前に表示した可視化ネットワークを表示した後、次の前に表示した可視化ネットワークに戻り表示したいとき。

4.7Options

>Transform
　　　可視化を変化させる。
1.Fit area
(a)max(x),max(y),max(z)
　　可視化の大きさをx,y,zでフィットさせる。
(b)max(x,y,z)
　　　実際の形を整えつつ、可視化エリアをフィットさせるように再調整する。

2.Resize
　選ばれた要素（x,y,z）の3方向すべてへ可視化を再調整する。

　　入力項目

　　　①Resize factor in x direction
      ②Resize factor in y direction

　　　③Resize factor in z direction

3.Translate
 可視化を空間上で変形（移動）させる。

①Translate factor in x direction

      ②Translate factor in y direction

　　　③Translate factor in z direction

4.Reflect y axis
　　y軸で可視化を反射させる。

5.Rotate 2D
　　x,y平面上で、指定された角度で回転させる。

6.Fisheye
　　可視化を、フィッシュアイ上に変形させる。

　　*Cartesian
　　　　直交（デカルト）座標上のフィッシュアイ

　　　　入力項目

　　　　　①amount of movement

             (「どれだけ動かすか？」で、値が大きいほど端に大きく寄る)
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図：amount of movement：3のFisheye *Cartesianの例
 *Polar

　極座標上のフィッシュアイ

入力項目

　　　　　①amount of movement

             (「どれだけ動かすか？」で、値が大きいほど端に大きく寄る)
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図：amount of movement：3の*Polar Fisheyeの例

>Valies of lines
>Mark vertices using
　ラベルやクラスの番号などを可視化したり、可視化を消去したりする。

1、 Labels(ctrl+L)
ラベルを可視化する。

2、 Numbers(ctrs+N)
頂点番号を可視化する。

3、 Partition Cluster

Partition（クラス番号）を可視化する。

4、 Vector Values

　　　Vectorの値（頂点の大きさ）を可視化する。

5、 No Labels(ctrl+D)
　　　ラベルを表示しない。または、消す。

6、 No Labels No Arrows

　　　有向線の向きの矢印とラベルを消去する。
7、 Mark Cluster Only

　　　　　現在クラスターに属している頂点のみ、ラベルを可視化する。
>Lines
　　ラインの可視化についてのメニュー
1.Draw Lines
(a)Edges
　無向線（Edges）を表示するかしないかのチェック。

(b)Arcs
　有向線（Arcs）を表示するかしないかのチェック。

(c)Relations
　選んだ関係番号のラインのみ表す。

関係番号：*.netファイルの*Arcs、*Edgesのライン定義の部分の上から、関係番号1,2,3･･･と自動的に付けられていく番号。*.netでは、ユーザーは入力したり、指定することはない。


[image: image326]
　　　　補足：関係番号1の行の意味は、頂点1から2へラインの値（重さ）1でつなげるという意味。

2.Mark Lines
　ラインのラベルや値の可視化。
(a)No

(b)with Labels
　ラインのラベルを可視化する。

(c)with Values
　ラインの値（重さ）を可視化する。

3.Different Widths
　　これをチェックすると、ラインの横幅がそのラインの値（重さ）に応じた幅になる。
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図：ラインの値（重み）をラインの幅で反映した可視化

4.GreyScale
　これをチェックすると、ラインがラインの値（重み）にしたがって、黒くなる。

　重みが少ない順から白→灰色→黒と灰色のスケール（GreyScale）になって可視化される。
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図：ラインの値（重み）を灰色のスケールで反映した可視化

　　　　　　補足：ラインの値（重み）が最小のものは、白で可視化され見えていない。
Different WidthsとGreyScaleは両立でき、両方チェックすると以下のように、ライン幅とグレースケールでラインの重みを可視化する。
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　　　　　図：ラインの値（重み）を灰色のスケールで反映した可視化

>Size
    以下のものの可視化サイズを変更する。
　　　　<of vertices
　　　　　　頂点の大きさのサイズ変更。

　　　　　　　入力項目

　　　　　　　①頂点の大きさ（0はauto）

        <of vertices defined in input file

　　　　　　*.netファイルの頂点の大きさの設定に従い頂点の大きさを変える。
	大きさの設定
	x_fact
	x軸方向に何倍拡大するか
	x_fact 3：x方向に3倍拡大

	
	y_fact
	y軸方向に何倍拡大するか
	x_fact 5：y方向に5倍拡大


　　　　　　　　表：*.netの頂点の大きさ設定
　　　　　　ただし、Vectorの大きさが入るとわかりにくくなる。

        <of vertitces Border

　　　　　　頂点の枠の横幅のサイズ変更。

入力項目

　　　　　　　①頂点の枠の横幅

        <of Lines

　　　　　　　ラインの横幅のサイズ変更。

        <of Arrows

　　　　　　　矢印のサイズ変更。

        <of Font

　　　　　　　フォントサイズの変更。

        <Default

　　　　　　　デフォルト設定へ戻す。
>Colors
　　　　<Back Ground

              可視化ウインドウのバックグラウンドの色の変更。

        <Vertices

　　　　　　　頂点の色の変更。

        <Vertices Border

　　　　　　　頂点の枠の色の変更。

        <Edges

　　　　　　　無向線の色の変更。

        <Arcs

　　　　　　　有向線の色の変更。

        <Font

　　　　　　　フォントの色の変更。

        <Partition Colors

Partitionの色設定を変更する。クラス番号に従い、可視化のときの色分け　　　　　　　　　

がなされるが、そのクラス番号と色の対応を設定できる。

        <Relation Colors

　　　　　　　Relationの色設定を変更する。
        <Default

　　　　　　　デフォルト設定に戻す。

>Layout
1.Redraw during moving

2.Real xy proportions

3.Arrows in the Middle

4.Size of vertex 0

(a)Hide vertex

(b)Hide attached lines

5.Decimal Places

6.Show SubLabel

>ScrollBer On/Off
　ScrollBarをON/OFF（出したり閉まったり）する。

  ScrollBar：可視化されたネットワーク3次元的を回転させるためのバー
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>Interrupt
　Interrupt：さえぎる; 妨げる; 中断する;割り込む(む), 中断（する）;インタラプト
>Previous/Next
1.Max number

2.Seconds to wait

3.Optimaize Layouts

(a)kamada-kawai

(b)2DFrucht.Rein

(c)3DFrucht.Rein

(d)No

4.Apply to

(a)Network

(b)Partition

(c)Vector
>Select all
4.8Export
　可視化されたネットワークを各種画像ファイルに送る。
>EPS/PS
　EPSフォーマットに送る。

　WYSIWYG：What You See Is What You Get(見たものは取得したもの)
　クリップかWYSIWYGを入れるか入れないか

　Partitionによって定義づけられた、色あるいは白黒の可視化ネットワークがEPSファイルデータとなる。

　PSフォーマットに送る。

　PS：Program stream

  MPEG-2システムにおけるプログラムストリーム。
>SVG
　SVG：Scalable Vector Graphics

          XMLによって記述されたベクターグラフィック言語のこと、或いは、SVGで記述された画像フォーマットのこと。

          SVG（XMLによって記述されたベクターグラフィック言語）やHTML内で使用することが出来る。

1.General
2.Labels/Arcs/Edges

3.Partition

(a)Classes

(b)Classes with semi-lines

(c)Nested Classes

4.Line Values

(a)Classes

(b)Nested Classes

(c-1)Options

(c-2)Different Colors

(c-3)Using GreyScale

(c-4)Different Widths

5.Multiple Relations Network

6.Current and all Subsequent
Subsequent：

>VRML
　VRML：Virtual Reality

          3次元の物体に関する情報を記述するためのファイルフォーマット。WWW上で利用されることを前提に設計された。
>MDL MOL file
  MDL MOL file：MOD Molfile format

  http://www.mdli.com  (Chemscape Chime).

>Kinemages
  Kinemages format：

1.Current Network Only

2,Current and all Subsequent

3,Multiple Relations Network

>Bitmap
　Bitmap：windowsの画像ファイル形式

>Options
　EPS、SVG、VRMLの初期設定のオプション
4.9Spin

>Spin around
　角度を指定して可視化ネットワークを回転させる。

>Perspective
　Perspective：遠近［透視］画法; 透視画; 遠景; 見通し, 展望; 正しい見方, 観点; 釣合い.
　頂点間の距離を小さく（あるいは、なく）可視化する。

>Normal
　標準頂点（Nomal vector）を旋回させる（Spin around）。

>Step in degrees
　回転描写したときのステップ次数

　Step in degrees：
4.10Move

>Fix
　1．X
　2．Y

　3．Radius

　　　Radius：半径

>Grid
　格子の位置を座標で指定すると、可視化画面に青い点が入る。この青い点を参考に、頂点の座標を見ることができる。

>Circle
　同心円の中心点の位置を座標で指定すると、可視化画面に青い点が同心円上に入る。この青い点を参考に、中心点からの頂点の座標を見ることができる。

>Grasp
　追加された頂点を動かす。

1.Closest Class Only

2.Closest Class and Higher

3.Closest Class and Lower

4.11Info
　以下の美的な特徴をの可視化を行う。

　このときの頂点は、0と1の間の値でないと処理できない。

　レポートにPartitionの方法が表示され、Partitionボックスに、*.cluファイルが生成される。

>Closest Vertices
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>Smallest Angle
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>Shortest/Longest Line
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>Number of crossings if lines
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>Vertex Closest to Line
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>All properties
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図：All Propatiesのレポート例
4.12可視化画面自体処理

頂点のクリック
　　1、頂点の右クリック

　　　　　その頂点のリンク情報の一覧ウインドウが表示される。そのウインドウで、新しいラインの追加を行うことが出来る。


[image: image340]
　２、頂点の左クリック

　　　　頂点を左クリックしたまま、ドラッグするとその頂点を移動させることが出来る。

Parririon毎に可視化したときのParititionの移動

　Parititonに左クリックをして移動させることが出来る。

可視化の拡大

　　頂点のない箇所で右クリックして、拡大したいエリアを指定するとその可視化ネットワークを拡大することが出来る。「Redarw」コマンドで拡大を解除できる。
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図：頂点Aベクトルの値に対する概念図


　　頂点Aに入ってくるベクトル数は、2であるため頂点Aのベクトル値は2である。





図：*.cluの役割
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図：入ベクトルが多くなると頂点の視覚化半径が大きくなる


この大きさは各頂点が持っているベクトル量が半径にフィードバックされた結果である





図：入ってくるベクトルと関係なく大きくなる頂点の視覚化半径（ベクトル量）
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図：オーソリティとハブ








ハブ





図：ハブ（無向線グラフのとき）





図：2部グラフ(2－Mode)の例





First subset





Second subset





Second subset





First subset





図：2部グラフ(2－Mode)の例





図：clsファイルの構成
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図：*.vecファイルの構成
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図：*perのファイル構造
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図：Partition> Binarizeの処理





Select cluster
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図：Partition> Fuse Clustersの処理
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First networkを入れるボックス





Second networkを入れるボックス





図：2つのネットワークとメインスクリーンのボックスの関係





図：*.timのファイル構造
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図：*clsのファイル構造
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図：*hieのファイル構造
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ライン(Edges・Arcs)の重み


line values


(arcsのときも同様)








図：line values








無向線





両向有向線





Edges->Arcs





図：Edges->Arcs





図：Arcs->Edges　*All





Arcs->Edges


*All








無向線





有向線





図：Arcs->Edges　*Bidirected only





Arcs->Edges
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元のArcs指定と反対方向のArcsを指定していることがわかる。





Edges->Arcs処理後の追加項目。








注目





つまり





両向有向線の指定は、


ある向きと、まったく逆向きの指定を行えばよい。





図：両向有向線と*.netの関係
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図：中心性





各頂点の中心性を反映した可視化





�





可視化


Draw-Vector





各頂点の中心性を計算したデータが入っている。
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図：*.netファイルとｒ： i j vの関係








図：有向線と無向線





有向線（Arc）





無向線（Edge）





図：両向有向線





頂点の再配置が行われても、
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図：上図perファイルのテキストエディタでの表示とEditとの比較
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右クリックで、変更先頂点番号を変更することが出来る。


例:52→30





図：PermutationのEditメニューの解説





変更先頂点番号のラベル（つまり変更されるラベル） 





変更頂点番号





元の頂点番号
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5-ring








図：*.netファイルと関係番号
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Different Widths





Different Widths





図：ラインの値（重み）とそのラインの幅での可視化
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図：ラインの値（重み）とその灰色のスケールでの可視化
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図：Empty Clusterファイルの頂点追加





ここをクリックして、頂点を入力し、手動でクラスターを作る。





Editをクリックして生成されるウインドウ
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クラスターの整理番号





クラスターに所属している頂点情報


（頂点番号―ラベル）





図：clusterボックスEditによるウインドウの説明
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図：*.perとPermutationボックスEditによるウインドウの説明





クラスターに所属している頂点情報


（頂点番号―ラベル）





Permutation番号
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この番号は、この番号と等しい頂点番号と、右側の頂点とを入れ替える目的のもので、入れ替え対象の頂点番号といっていい。





図：*.netファイルの構成（Vertices宣言部分）





頂点の宣言
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頂点の座標
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頂点の詳細設定


（eg.大きさ、色など）





ラベル





頂点番号
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*Verteces 頂点数


頂点の宣言部分





*Arcs 


　　　有向線の宣言部分





ラインの宣言部分





*Edges


　　　無向線の宣言部分





図：*.netファイルの大まかな構成
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d1の計算と可視化








頂点数20のCompleteクラスター





図：Dissimilarityのd1処理過程





次数中心性が高い（ハブ・オーソリティに近い）





図：次数中心性とハブ・オーソリティ





Line value(ラインの値・重さ)





頂点の距離が近い順に並び替えた頂点





Islandの基準の値





Island





図：3.OUT





頂点の距離が近い順に並び替えた頂点





図：Island生成の原理





図：Core生成の原理





最大サブグラフのみIsland





最大サブグラフのみCore
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Get Loops





ループのある頂点をVector：1へ、それ以外は0へ





図：Get Loops





Vectorファイル
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図：xのCoordinateの例
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図：Summing up Values of Linesの処理





図：Min of Valuesof Linesの処理
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図：Max of Valuesof Linesの処理





弱い頂点（次数の少ない）からセンターへと次数の移動�





図：Center生成の概念図
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5種類のBrokerage Rolesの5つのPartitionファイルが生成





焦点を対象頂点と考えると、離心率の大きい楕円ほど、他の頂点の距離の総和が大きいとみなす。総和が大きいほど離れている





媒介中心性：大





媒介中心性：小





図：離心率と媒介中心性





円は焦点がない。つまり、離心率0。それは、他の頂点距離総和が0と同じである。





� EMBED Equation.3  ���





� EMBED Equation.3  ���





� EMBED Equation.3  ���





最短経路でない。





最短経路





図：最短経路� EMBED Equation.3  ���
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� EMBED Equation.3  ���
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最短経路が短いほど近接中心性が高い





図：最短経路と近接中心性
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Union　of　lines





図：Union of lines





右のネットワークのライン（青）が左のネットワーク（黒）へ合成される。
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図：元ネットワーク内の30から120までの経路（黄色）kamada-kawai最適化





図：Path
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環状になっている。非環状（acyclic）ネットワークでない。





図：環状ネットワーク





Kamada-kawai最適化による可視化。（他の可視化のときは環状かどうかわかりにくい。
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出頂点
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ラインの値（重み）





詳細設定





図：*.netのラインの設定
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*1-mode








図：Transpose *1-mode
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図：2-modeのランダムネットワーク





First subset





Second subset
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図：Transpose *2-mode








First subsetとSecond subsetが変換されている。
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ある頂点間の特定のライン


（= Multiple Lines）





両向有向線
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無向線
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頂点数100非環ネットワークの端点をつなげる頂点101、102が生成される。


つまり、Sinkする。非環ネットワークの始まりが101で終わりが102になる。





図：Add *Source and Sinkの例





重みが違う





*Arcs


1        2 1


2        1 10





図：*Sibling Edges inputの例
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図：Add *Source and Sink








この状態が、Sink（流す）状態である。





追加される頂点（始点）





追加される頂点（終点）





矢印方向の有向ネットワーク





無向線になったときの値は？





以下の3つの中で調整する。





ラインの値（重み）が大きい





たくさん伝播する。


（あるいはその結果、ラインの値（重み）が大きくなった。）





ラインの値（重み）が小さい。





少ししか伝播しない。


（あるいはその結果、ラインの値（重み）が小さくなった。）





Line value=10





Line value=1





図：ラインの値（重み）と伝播





Lowest value of line:  1.0000


Highest value of line: 100.0000





         Line Values             Frequency       Freq%  CumFreq  CumFreq%


--------------------------------------------------------------------------


 (            ...     1.0000]          673     99.8516      673   99.8516


 (     1.0000 ...     3.0204]            0      0.0000      673   99.8516


 (     3.0204 ...     5.0408]            0      0.0000      673   99.8516


 (     5.0408 ...     7.0612]            0      0.0000      673   99.8516


 (     7.0612 ...     9.0816]            0      0.0000      673   99.8516


 (     9.0816 ...    11.1020]            0      0.0000      673   99.8516


 (    11.1020 ...    13.1225]            0      0.0000      673   99.8516


 (    13.1225 ...    15.1429]            0      0.0000      673   99.8516


 (    15.1429 ...    17.1633]            0      0.0000      673   99.8516


 (    17.1633 ...    19.1837]            0      0.0000      673   99.8516


 (    19.1837 ...    21.2041]            0      0.0000      673   99.8516


 (    21.2041 ...    23.2245]            0      0.0000      673   99.8516


 (    23.2245 ...    25.2449]            0      0.0000      673   99.8516


 (    25.2449 ...    27.2653]            0      0.0000      673   99.8516


 (    27.2653 ...    29.2857]            0      0.0000      673   99.8516


 (    29.2857 ...    31.3061]            0      0.0000      673   99.8516


 (    31.3061 ...    33.3265]            0      0.0000      673   99.8516


 (    33.3265 ...    35.3469]            0      0.0000      673   99.8516


 (    35.3469 ...    37.3674]            0      0.0000      673   99.8516


 (    37.3674 ...    39.3878]            0      0.0000      673   99.8516


 (    39.3878 ...    41.4082]            0      0.0000      673   99.8516


 (    41.4082 ...    43.4286]            0      0.0000      673   99.8516


 (    43.4286 ...    45.4490]            0      0.0000      673   99.8516


 (    45.4490 ...    47.4694]            0      0.0000      673   99.8516


 (    47.4694 ...    49.4898]            0      0.0000      673   99.8516


 (    49.4898 ...    51.5102]            0      0.0000      673   99.8516


 (    51.5102 ...    53.5306]            0      0.0000      673   99.8516


 (    53.5306 ...    55.5510]            0      0.0000      673   99.8516


 (    55.5510 ...    57.5714]            0      0.0000      673   99.8516


 (    57.5714 ...    59.5918]            0      0.0000      673   99.8516


 (    59.5918 ...    61.6122]            0      0.0000      673   99.8516


 (    61.6122 ...    63.6326]            0      0.0000      673   99.8516


 (    63.6326 ...    65.6531]            0      0.0000      673   99.8516


 (    65.6531 ...    67.6735]            0      0.0000      673   99.8516


 (    67.6735 ...    69.6939]            0      0.0000      673   99.8516


 (    69.6939 ...    71.7143]            0      0.0000      673   99.8516


 (    71.7143 ...    73.7347]            0      0.0000      673   99.8516


 (    73.7347 ...    75.7551]            0      0.0000      673   99.8516


 (    75.7551 ...    77.7755]            0      0.0000      673   99.8516


 (    77.7755 ...    79.7959]            0      0.0000      673   99.8516


 (    79.7959 ...    81.8163]            0      0.0000      673   99.8516


 (    81.8163 ...    83.8367]            0      0.0000      673   99.8516


 (    83.8367 ...    85.8571]            0      0.0000      673   99.8516


 (    85.8571 ...    87.8775]            0      0.0000      673   99.8516


 (    87.8775 ...    89.8980]            0      0.0000      673   99.8516


 (    89.8980 ...    91.9184]            0      0.0000      673   99.8516


 (    91.9184 ...    93.9388]            0      0.0000      673   99.8516


 (    93.9388 ...    95.9592]            0      0.0000      673   99.8516


 (    95.9592 ...    97.9796]            0      0.0000      673   99.8516


 (    97.9796 ...   100.0000]            1      0.1484      674  100.0000


--------------------------------------------------------------------------


  Total                                674    100.0000








(    49.4898 ...    51.5102]            0      0.0000      673   99.8516


 (    51.5102 ...    53.5306]            0      0.0000      673   99.8516


 (    53.5306 ...    55.5510]            0      0.0000      673   99.8516


 (    55.5510 ...    57.5714]            0      0.0000      673   99.8516


 (    57.5714 ...    59.5918]            0      0.0000      673   99.8516


 (    59.5918 ...    61.6122]            0      0.0000      673   99.8516


 (    61.6122 ...    63.6326]            0      0.0000      673   99.8516


 (    63.6326 ...    65.6531]            0      0.0000      673   99.8516


 (    65.6531 ...    67.6735]            0      0.0000      673   99.8516


 (    67.6735 ...    69.6939]            0      0.0000      673   99.8516


 (    69.6939 ...    71.7143]            0      0.0000      673   99.8516


 (    71.7143 ...    73.7347]            0      0.0000      673   99.8516


 (    73.7347 ...    75.7551]            0      0.0000      673   99.8516


 (    75.7551 ...    77.7755]            0      0.0000      673   99.8516


 (    77.7755 ...    79.7959]            0      0.0000      673   99.8516


 (    79.7959 ...    81.8163]            0      0.0000      673   99.8516


 (    81.8163 ...    83.8367]            0      0.0000      673   99.8516


 (    83.8367 ...    85.8571]            0      0.0000      673   99.8516


 (    85.8571 ...    87.8775]            0      0.0000      673   99.8516


 (    87.8775 ...    89.8980]            0      0.0000      673   99.8516


 (    89.8980 ...    91.9184]            0      0.0000      673   99.8516


 (    91.9184 ...    93.9388]            0      0.0000      673   99.8516


 (    93.9388 ...    95.9592]            0      0.0000      673   99.8516


 (    95.9592 ...    97.9796]            0      0.0000      673   99.8516


 (    97.9796 ...   100.0000]            1      0.1484      674  100.0000


--------------------------------------------------------------------------


  Total                                674    100.0000








図：*Recodeによって出力される結果Reportの例
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図：ScrollBer





*.netファイルでは、


*Edges


1　1　　1


と表現される。（ラインの値1の場合）
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図：Loopと*.netファイルの構成





0の隣接





1の隣接





次数0





次数1





図：0の隣接と1の隣接





他の1つの頂点と隣接している





図：Reduction *Subdivisions
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図：All degreeのpartitionに従ったMc Cabe描写
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部分集合25と25の同じ頂点数の2-mode





頂点数25（つまり半分の）1-modeへ





図：2-mode to 1-mode *Rows=Cols
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頂点番号1~25の1-modeネットワーク





倍の25頂点が追加され、51番目の頂点に集中する形となる。
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Kamada-kawai最適化
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中央のオーソリティが51.





図：Multiple relation  *Generate 3-Mode Network
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図：グラフ
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Opposite arcs
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図：Undirectedの3-ringの例








3-ring上に重みが付けられ、灰色のラインで3-ringが可視化されていることがわかる。





図：無向線ネットワーク(Undirected)の3-ring
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図：Undirectedの4-ringの例








4-ring上に重みが付けられ、灰色のラインで4-ringが可視化されていることがわかる。





図：無向線ネットワーク(Undirected)の4-ring





可視化の違いのみでこれも4-ring





*.netファイル





仮想ネットワークデータ





実測調査





Pajek





各種ファイル





ネットワーク可視化





各種処理





図：Pajekの処理の流れ





図：Core生成の原理





1.LSSC





2.IN








Core





Islandの基準の値





頂点の距離が近い順に並び替えた頂点





次数





この閾値の線の上昇がステップ。


Coreが変わっていく。
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図：clique





クリークから、確率pだけラインを引いたクリーク(p-clique)





図：p-clique





図：3-ringから5-ringの可視化





4-ring








3-ring





このショートカットが潰れてしまうと、迂回しWalkに大きなパス数を使わないといけない。


つまり媒介中心性が高い。





頂点とリンクの密集地





図：媒介中心性の高い頂点の特徴(その1)





ショートカット





ハブが潰れることは、最短パスが潰れることになる可能性が高い。


よって、媒介中心性が高い。





ハブが潰れたら、このパスのような大きいパス数の迂回路を使うことになる。





Start





Goal





図：媒介中心性の高い頂点の特徴(その2)
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数理モデル


（数式）





統計処理


(R・SPSS)





中心部分
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図：2.IN





2.INから3.OUTまでつながっているが明確な流れがない。





3.OUT
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図：1.SSCL
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k-core





クラス番号に明確な線引きがされる。この場合、次数3と4の間にある。定義より、これは4-core。





図：Degree Partitionとk-coreの違い
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図：自動的に決定されるk-core





コンピュータ（Pajek） は、このネットワークに対しコア数2を選択。つまり2-core





次数k以上のサブグラフを作り、そのクラス番号を2とし、それ以外を1とする。








最大なサブグラフ以外は、すべて次数に限らずクラス番号を1とする。





最大のサブグラフのみ、クラス番号2となる。





k-core





図：k-coreの形成過程
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ラインはそのままである。





つまり、ネットワークのある頂点の位置に再配置先の頂点がすべてのデータをもって再配置される。





図：*.netファイルと再配置
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座標を反映すると





ラインはまったくいじらないが、頂点のすべての情報を入れ替える（座標情報も）
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つまり、処理としては頂点の再配置であるが、やっていることはラインの張替えである(Rewire)
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頂点の再配置





整理（並び替え）





相対的にラインの張替えであることがわかる。





図：上図の次数に注目したもの





図：Permutainonで行っていること
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クラスター数を頂点番号と同じにした





図：Make Partition
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Parmutationファイル(*.per)
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クラスター数を入力








仮想的な再配置によるネットワーク生成





ファイルが生成されない。





この生成されたネットワークをクラスター番号でPartition化





Parititonファイル(*.cls) 生成





図：Make partitionの処理手順
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図：Make Vector
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定義数から数えて、元のネットワークの頂点数と同じクラスター





頂点を追加・削除してクラスターを整える。





図：Create Complete Cluster
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クラスターに属さない頂点
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元ネットワークのうち、クラスターに属している頂点と属していない頂点がParitionの色分けで可視化できる。





図：Make Partition
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2-modeネットワーク（2部グラフ）





2-modeのPartition





Firstsubsetと


Secondsubset





Partitionを反映した可視化





図：Partition 2-mode
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図：Traiadic Census








Vertexと書かれているが、


Traiadicの種類番号である。





Valと書かれているが、


Traiadicの種類番号に対応するTraiadicの数である。





Vertexと書かれているが、


Traiadicの種類番号である。





Valと書かれているが、


Traiadicの種類番号に対応するTraiadicの予測数である。





図：Expected Traiadic Census
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図：Triadic Censusの処理過程
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図：info Perritionの処理過程
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図：ハイダーのモデル例
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図：Empty Cluster
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Partition（クラスター）は*.clsで定義される。
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図：ネットワークとPajekの対象範囲
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図：階層ネットワーク
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図：メインスクリーンの各ボックスと読み込まれるファイルの種類（拡張子）
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図：動的ネットワークと*.tim
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図：Pejke、4つのウインドウ











各種ファイルの読み書きがなされる





各種処理を行うためのコマンド





図：メインスクリーンの構造
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クラス番号毎に色分けして可視化される。





可視化
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図：*.cluのクラス番号と色分けの色の設定
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上から頂点番号1のクラス番号1、頂点番号2のクラス番号3・・・という構成である。頂点番号はデータから省略されている。
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図：クラス番号毎の色分けの例





図：*.vecファイルの役割
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図：Vector量と可視化時の頂点の大きさ





頂点





Vector量大











上から頂点1のVector量、頂点2のVector量・・・という構成になっている。頂点番号はデータから省略されている。





図：*.perファイルの役割
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図：頂点再配置とラインの張替え





つまり、処理としては頂点の再配置であるが、やっていることはラインの張替えである(Rewire)
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上から頂点番号1の再配置頂点、頂点2の再配置頂点である。つまり、1→102、2→35・・・となる。張替え元の頂点番号はデータから省略されている。





図：*.clsの役割
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図：*.clsのメインスクリーンのEditの表示








図：*.hieファイルの役割
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図：*.hieから階層ネットワークを作成した例





Hierarchy>Make network





*.hie





�





�





*.clu





�





First Box





Second Box





Third Box





各Partitionボックスを以上のように名づける。





図：Partitionボックス
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図：右クリックによる範囲指定での可視化の拡大
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